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Chapter 1: Administering the JSS




Overview of Technologies

Applications and Utilities

This section describes the applications and utilities that make up the Casper Suite.

JSS Installers

JSS Installers provide a quick, easy way to install and upgrade the JAMF Software Server (JSS). JSS Installers
are available for the following platforms:

= Mac
= Linux

= Windows

JSS Installer for Mac

The JSS Installer for Mac is an installation package that allows you to install and upgrade the JSS on Mac
OS X Server. It also allows you to create your initial distribution point during a fresh installation.

Note: The JSS Installer for Mac included in the product DMG (JSS Installer.mpkg)is unsigned.To
obtain a signed version of the JSS Installer for Mac (JSS Installer.pkg), contact JAMF Software
Support. The signed version allows you to install or upgrade the JSS when Apple’s Gatekeeper feature is
set to only allow applications downloaded from the Mac App Store and identified developers.

JSS Installers for Linux and Windows

The JSS Installers for Linux and Windows allow you to install and upgrade the JSS on supported Linux and
Windows operating systems.

To obtain these installers and their documentation, see the introductory email that you received from
JAMF Software or contact your JAMF Software Representative.




Mac OS X Applications

Casper Admin

The Casper Admin application is a repository for packages, scripts, printers, and Dock items. Casper Admin
allows you to create and maintain configurations (similar to images) using these items and manually
replicate distribution points.

The JSS also has an implementation of Casper Admin that is almost identical to the application with a few
exceptions. The JSS implementation of Casper Admin does not allow you to perform the following actions:

= Copy packages to distribution points.

= Delete files from distribution points.

= Replicate distribution points or FireWire drives.
= Add new printers.

= Add and manage Dock items.

= |dentify Adobe Installers and Adobe Updaters.

= Index packages.

Conversely, the following actions can only be performed using the JSS implementation of Casper Admin:
= Specify Self Healing data for packages.
= View the contents of an indexed package.

= (Create directory bindings.

Casper Imaging

The Casper Imaging application is used to image local drives. It provides two options for automating the
imaging process: Autorun and PreStage imaging.

Casper Imaging can also be used to run scripts, map printers, create local user accounts, bind to Active
Directory, and automate other common postfix tasks.

Casper Remote

The Casper Remote application allows you to perform the following tasks on remote computers:
= Distribute software.

= Run Apple’s Software Update.

= Run scripts.

= Map printers.

= (Create local user accounts.

= Bind to Active Directory.

= Automate other management tasks.

Casper Remote allows you to perform the same management tasks as a policy, but the actions take place
immediately over a Secure Shell (SSH) connection instead of waiting for clients to check in to the JSS.



Composer

The Composer application is used to build packages from software, applications, preference files,
documents, and other installable items. Building packages allows you to break down images into smaller,
deployable components that facilitate a modular approach to the imaging process.

JAMF Software Server

The JSS is a web application that serves as the administrative core of the Casper Suite. All other JAMF
Software administrative applications communicate with the JSS.

The JSS allows you to perform remote management tasks on enrolled computers, such as deploying
policies or restricting software. It also allows you to perform over-the-air management tasks on enrolled
mobile devices, such as installing configuration profiles or distributing apps.

In addition, you can use the JSS to collect and view inventory for computers and mobile devices regardless
of their enrollment status.

Recon

The Recon application allows you to acquire Mac OS X computers to create your inventory and collect
data, such as hardware, applications, fonts, and plug-ins.

Self Service

The Self Service application allows users to run pre-configured management tasks (policies) on their
computers. Using an interface similar to iTunes, users can point-and-click their way through management
tasks, such as installing software, running Software Update, and mapping printers.

Plug-ins can also be added to Self Service for additional functionality. They can be a web page or an actual
plug-in file that is written for Self Service. Plug-ins are stored in the following location on client computers:

/Library/Application Support/JAMF/Self Service/

iOS Applications

Self Service Web Clip

The Self Service web clip is added to enrolled devices by default. It allows you to distribute configuration
profiles, apps, eBooks, and updated MDM profiles to devices for users to install. Users tap the web clip to
browse and install items using an interface similar to the App Store.

You can configure settings for the Self Service web clip using the Mobile Device Management Framework
settings in the JSS.
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Windows Applications

Recon.exe

The Recon.exe application allows you to acquire Windows computers to create your inventory and collect
data, such as hardware, applications, fonts, and plug-ins.

Utilities
JAMF Helper
The JAMF Helper displays messages to users. It is stored in the following location on client computers:

/Library/Application Support/JAMF/bin/

JSS Database Utility

The JSS Database Utility allows you to back up and restore the jamfsoftware database. It also allows you to
restart Apache Tomcat and MySQL and modify their settings.

/usr/sbin/jamf (jamf binary)

Most tasks in the Casper Suite are executed using the “jamf” command-line application (also known as the
jamf binary). Although you are free to use this application at will, the Casper Suite automatically installs,
updates, and runs it.

11



Ports

The following table describes the main ports used to host communication among client computers,
distribution points, and the JAMF Software Server (JSS):

Port Used for

22 The standard port for SSH (known as remote login in Mac OS X).

80 The standard port for HTTP. If you use HTTP to deploy packages or scripts, they are
downloaded on this port.

443 The standard port for HTTPS. If you use HTTPS to deploy packages or scripts, they are
downloaded on this port.

548 The standard port for Apple File Protocol (AFP). If you use an AFP share to deploy
packages or scripts, clients mount the AFP share on this port.

3306 The default port for MySQL.

8443 The SSL port for the JSS. Default port used by applications and enrolled computers and
mobile devices to connect to the JSS.

The following table describes other commonly used ports:

Port Used for

25 The standard port for SMTP. The JSS connects to an SMTP server to send email
notifications to administrators.

139 If you use an SMB share to deploy packages or scripts, clients mount the SMB share on
this port.

389 The standard port for LDAP. Any LDAP connections—even those coming from other
applications—go through the JSS. This means that only the JSS connects to your LDAP
server.

445 If you have an SMB client, such as “DAVE", installed on your client computers, they may
mount the SMB share on this port.

514 The default port for Syslog servers.

2195 The port used to send messages from the JSS to Apple Push Notification service (APNs).

2196 The port used for feedback from APNs.

5223 The port used to send messages from APNs to the mobile devices and computers in
your network.

8080 The HTTP port for the JSS on Linux and Windows platforms. Although it is available,
applications do not connect to this port unless the defaults are overridden.

9006 The HTTP port for the JSS on the Mac platform. Although it is available, applications do
not connect to this port unless the defaults are overridden.

12



On the Mac platform, the JSS runs on ports 8443 and 9006 by default. On Linux and Windows platforms,
the JSS runs on 8443 and 8080 by default. If you decide to change these ports, you must change the
port information in Tomcat’s server . xml file and in the Preferences window for each Casper Suite
application.

You cannot change the default ports for SSH or SMB with the Casper Suite.
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Security

This section explains the primary security measures in the Casper Suite:
= Passwords

= Communication protocols

= Public key infrastructure

= Signed applications

Passwords

The Casper Suite allows you to store individual accounts for client computers and reset the passwords if
necessary.

Passwords stored in the database are encrypted using a standard 128-bit RSA encryption with a 1024-bit
key.

Communication Protocols
The Casper Suite has security built into its design. Connections between the JAMF Software Server (JSS),
the other applications in the Casper Suite, and mobile devices take place over Secure Sockets Layer (SSL).

The Casper Remote application and the network scanner in the Recon application connect to clients over
Secure Shell (SSH), or remote login.

Secure Shell (SSH)

SSH is a network security protocol built into Mac OS X. For more information, go to:

http://openssh.org/

Secure Sockets Layer (SSL)

SSL is a security protocol for Internet communication. For more information, go to:

https://www.openssl.org/

Public Key Infrastructure

A public key infrastructure (PKI) is the design by which digital certificates are obtained, managed, stored,
and distributed to ensure a secure exchange of data over a public network. For more information on PKiI,
go to:

https://en.wikipedia.org/wiki/Public_key infrastructure
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Certificate Authority

A certificate authority (CA) is a trusted entity that signs and issues the certificates required for certificate-
based authentication. It is the central component of the PKI.

The JSS has a built-in CA that is enabled by default, but you can integrate it with third-party CA if you
prefer.

For more information on CAs, go to:

https://en.wikipedia.org/wiki/Certificate authority

Simple Certificate Enrollment Protocol

Simple Certificate Enrollment Protocol (SCEP) obtains certificates from the CA and distributes them to
enrolled mobile devices, allowing over-the-air management tasks to take place.

The CA hosted by the JSS is SCEP-enabled by default. If you plan to use a third-party CA, it must be SCEP-
enabled.

Certificates

Certificates are electronic documents that validate the identity of a public key to ensure the encryption of

data and establish trust.

Web Server Certificate

This certificate validates the identity of the JSS and establishes trust between the JSS and clients. Choosing

to install this certificate prevents possible man-in-the-middle attacks by allowing clients to validate the

certificate when connecting to the JSS. Clock skew can also be reduced to prevent the replay of messages

from the JSS to client computers.

If you are using the Casper Suite for mobile device management, you need a web server certificate to
ensure that the devices are communicating with a valid JSS.

CA Certificate
This certificate establishes trust between the CA and Mac OS X clients, and between the CA and enrolled
mobile devices.

Signing Certificate
This certificate is used to sign messages passed between the between the JSS and Mac OS X clients, and
between the JSS and enrolled mobile devices.

Apple Push Notification Service Certificate
This certificate authenticates the JSS to Apple Push Notification service (APNs).

Device Certificate
This certificate validates the identity of Mac OS X clients and enrolled mobile devices each time they
communicate with the JSS.
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Signed Applications

The following applications are signed by JAMF Software:
= Casper Admin

= CasperImaging

= Casper Remote

= Composer

= JAMF Helper

= JSSInstaller for Windows (JSS Installer.msi)
= Recon

= Recon.exe

= Self Service

= /usr/sbin/jamf (jamf binary)

A signed version of the JSS Installer for Mac (JSS Installer.pkg)is also available. You can obtain it by

contacting JAMF Software Support.
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Requirements

This section lists the requirements for the following components and functions of the Casper Suite:
= JAMF Software Server

= JSS Installers

= JSS Database Utility

= Package building

= |nventory

= |maging

= Remote management

= Self Service

= Mobile device management

JAMF Software Server

You can host the JAMF Software Server (JSS) on any server that meets the following minimum
requirements:

= Javal6
= MySQL 5.1 or later

= Apache Tomcat 6.0 or later

Tested operating systems include:

= OSXServerv10.6

= OSXServervi10.7

= OSXServerv10.8

= Ubuntu 10.04 LTS Server

= Ubuntu 12.04 LTS Server

= Red Hat Enterprise Linux (RHEL) 6
= Windows Server 2008

Although you can install the JSS on any server that meets the minimum requirements, the JSS Installers
for Mac, Linux, and Windows have additional requirements. (See the “JSS Installers” section for detailed
information.)

17



JSS Installers

JSS Installer for Mac

The JSS Installer for Mac requires a Mac computer with:

A 64-bit capable Intel processor
2 GB of RAM

400 MB of disk space available
OS X Server v10.6 or later

Java 1.6

MySQL Enterprise Edition 5.5 or later (recommended) or MySQL Community Server 5.5 or later,
available at:

https://www.mysgl.com/downloads/
Ports 8443 and 9006 available

JSS Installers for Linux and Windows

Requirements for the JSS Installers for Linux and Windows are available in the JAMF Software Server
Installation Guides for Linux and Windows. To obtain the JSS Installer for Linux or Windows along with its
installation guide, contact your JAMF Software Representative, or visit the following website and log in
with a valid JAMF Nation account:

https://jamfnation.jamfsoftware.com/myAssets.html

JSS Database Utility

The JSS Database Utility requires a server with MySQL Server 5.1 or later.

Package Building

Composer can run on the following operating systems:

0OS Xv10.5.x
0OS Xv10.6.x
OS X v10.7.x
0OS Xv10.8.x

Inventory

Recon can run locally on the following operating systems:

OS Xv10.5.x
OS Xv10.6.x


http://www.mysql.com/downloads/
https://jamfnation.jamfsoftware.com/myAssets.html

Recon can remotely acquire computers with the following operating systems:

OS Xv10.7.x

0OS Xv10.8.x
Windows 2000
Windows XP
Windows Server 2003
Windows Vista
Windows Server 2008
Windows 7

0OS Xv10.5.x
OS Xv10.6.x
OS X v10.7.x
0OS Xv10.8.x

Older versions of Recon (available by contacting JAMF Software Support) can remotely acquire computers

with the following operating systems:

Recon can acquire synced mobile devices with iOS 4 or later.

Mac OS v8.6
Mac OS v9.x
OS X v10.1.x
OS Xv10.2.x
OS Xv10.3.x
OS X v10.4.x
Windows NT4
Windows ME

Imaging

Casper Imaging can image computers with OS X v10.5.x, OS X v10.6.x, OS X v10.7.x, or OS X v10.8.x that do

not have PowerPC processors.

Remote Management

Policies can be used to manage computers with the following operating systems:

0OS Xv10.5.x
0OS Xv10.6.x
0OS Xv10.7.x
0OS Xv10.8.x
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Casper Remote can be used to manage computers with OS X v10.5.x, OS X v10.6.x, OS X v10.7.x, or OS X
v10.8.x that do not have PowerPC processors.

Self Service

Self Service can run on the following operating systems:
= OSXv10.5.x

= OSXv10.6.x

= OSXv10.7.x

= OSXv10.8x

Mobile Device Management

The Casper Suite can be used to enroll and manage mobile devices with iOS 4 or later.
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Installing and Managing the
JSS

Required Components

This section describes the components that run the JSS.

Java

Java 1.6 is required to start the Tomcat web application server that runs the JSS.

MySQL

The JSS stores information in a MySQL database. For more information about MySQL, go to:

https://www.mysgl.com/

Apache Tomcat

The JSS runs on Tomcat, a web application server similar to Microsoft’s Internet Information Server (IIS). For
more information about Tomcat, go to:

https://tomcat.apache.org/
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Installing the JSS on Mac OS X Server

Installing the JAMF Software Server (JSS) involves the following steps:
Install the required software (if you haven't already).
Create the jamfsoftware database.

Run the JSS Installer.
This section includes details for each step.

Before you begin, review the “Requirements” section and make sure that your server meets the JSS Installer
requirements.

Note: The instructions in this guide are for the Mac platform only. To obtain the JSS Installer for Windows
or Linux along with its installation guide, contact your JAMF Software Representative, or visit the
following website and log in with a valid JAMF Nation account:

https://jamfnation.jamfsoftware.com/myAssets.html

For instructions on how to manually install the JSS on Linux and Windows, download the "Manually
Installing the JAMF Software Server" technical paper from:

http://jamfsoftware.com/libraries/pdf/white papers/Manually Installing the JAMF Software Server.
pdf

Step 1: Install the Required Software
Java and MySQL must be installed on the server before you can create the jamfsoftware database and
run the JSS Installer. For instructions on how to install and configure Java and MySQL, see the following

Knowledge Base article:

https://jamfnation.jamfsoftware.com/article.html?id=28

Step 2: Create the jamfsoftware Database

Create a MySQL database in which the JSS can store its data, and a MySQL user can access it. Name the
database “jamfsoftware” and give the MySQL user the following credentials:

= Username: jamfsoftware

= Password: jamfsw03

Note: If you customize the database name, username, or password, you will be prompted to enter the
custom settings when you run the JSS Installer.
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To create the jamfsoftware database:
Open Terminal and access the MySQL command line as "root" by typing:
mysql -u root -p

If MySQL is not in the path or it is installed in a custom location, access the MySQL command line by
updating the path or by typing:

/path/to/mysql -u root -p

Note: On OS X v10.7 or later, the default path for MySQL is /usr/local/mysql/bin/.

When prompted, enter the password for the MySQL “root” user.
If you did not create a root password, press the Return key.

Create a database named "jamfsoftware" by executing:
CREATE DATABASE jamfsoftware;
Grant permissions to a MySQL user named "jamfsoftware" so that it can access the new database:

GRANT ALL ON jamfsoftware.* TO 'jamfsoftware'@localhost IDENTIFIED BY
'jamfsw@3';

Note: If you choose to enter a username other than "jamfsoftware’, it is recommended that you do not
use "root".

Step 3: Run the JSS Installer

Run the JSS Installer to install Apache Tomcat and the JSS web application, and create your initial
distribution point.

To run the JSS Installer:

Copy the JSS Installer for Mac to the server.

Note: The JSS Installer for Mac included in the product DMG (JSS Installer.mpkg)is unsigned.To
obtain a signed version of the JSS Installer for Mac (JSS Installer.pkg), contact JAMF Software
Support. The signed version allows you to install or upgrade the JSS when Apple's Gatekeeper feature is
set to only allow applications downloaded from the Mac App Store and identified developers.

Double-click the installer and click Continue to proceed.
When the Introduction pane appears, click Continue.

Read the information on the Read Me pane, and then click Continue.
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Select a drive on which to install the software, and then click Continue.

Modify the information on the Database pane to reflect any custom settings if needed, and then click
Continue.

Click Install.
Enter your administrator password when prompted, and then click OK or Install Software.

When the installation is complete, follow the instructions on the Summary pane to access the JSS. Then,
click Close.
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Allocating Additional Memory to Tomcat

This section explains how to:
= View the amount of memory being used by the web application

= Allocate additional memory to Tomcat

To view web application memory usage:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Database/Web Application Health link.
Click the Web App Memory link.

To allocate additional memory to Tomcat using the JSS Database Utility:

Open the JSS Database Utility on the server running the JSS.
The JSS Database Utility is located in:
/Library/31SS/bin/JSSDatabaseUtil. jar

Enter the username and password for an administrator account to the server, and then click OK.

If the JSS Database Utility is unable to locate the MySQL binary, you are prompted to enter the path. Click
Continue and enter the location of the binary.

From the menu bar, choose Utilities > Change Tomcat settings.

Modify the minimum and maximum memory and PermGen sizes as needed.

800 Tomcat Settings

Tomcat Settings
S

Minimum Memory: 1024 MB

Maximum Memory: 4096 MB

Minimum PermGen Size: 256 MB

Maximum PermGen Size: 512 MB

| Cancel | [ Apply Settings ]
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6. Click Apply Settings.

7. When prompted to restart Tomcat, click Yes.




5.

Setting Up the JSS

The first time you connect to the JAMF Software Server (JSS), the JSS Setup Assistant guides you through

creating your first account and configuring the basic computer management framework.

To set up the JSS:
Log in to the JSS with a web browser.
Read the License Agreement and click Agree.

Enter the name of your organization and the activation code you received from your JAMF Software
Representative, and then click Continue.

If you did not receive an activation code, send an email to sales@jamfsoftware.com.

155 Setup Assistant

Activation Code Account Management Complete

Activation Code

Specify the name of your organization and activation code.
If you do not have an activation code, please contact JAMF Software at sales@jamfsoftware.com.

Organization Name: JAMF Software, LLC

Activation Code: | ABCD-EFGH-|JKL-MNOP|

Enter a username and password to create your first administrator account in the JSS.

]SS Setup Assistant

Activation Code Account Management Complete

Initial JSS Account

Create your first account in the J55.

Password:

Verify Password:

Enter the password again to verify it, and then click Continue.
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6.

8.

Verify the URL for your JSS, and then click Continue.
The URL must include the correct protocol, domain, and port. For example:
https://jss.mycompany.corp:8443/

JS5 Setup Assistant

Activation Code Account Management Complete

Enter the URL for the JSS that clients should connect to
This URL will be used by the computers and mobile devices to locate the JSS.
Note: For Mobile Device Management, this URL cannot use an IP Address.

Warning: If clients cannot connect to the J5S at the address entered, they cannot be managed by the JS5.

J55 URL: Iht(ps‘Hjss.mytumpany\mm:ﬂ-ﬂ!,i |

o

Choose how often you want computers and mobile devices to submit inventory reports to the JSS, and
then click Continue.

For computers, this automatically creates a policy to enforce the inventory schedule. For more information
on policies, see the “Policies” section.

IS5 Setup Assistant

Activation Code Account Management Complete

How often do you want clients to submit inventory reports?

For client computers, a Policy is automatically created to enforce this task. For mobile devices, the J55
will request a new report when the last report is older than the specified time.

Computers Mobile Devices

) Once every day ® Once every day
) Once every week ) Once every week
) Once every month ) Once every month

() Configure manually later

s

Choose how often you want computers to check in for policies, and then click Continue.

JS5 Setup Assistant

Activation Code Account Management Complete

How often do you want computers to check for available Policies?

A Scheduled Task is automatically created to enforce this task.

() Every 5 minutes

e Every 15 minutes

() Every 30 minutes (Recommended for 10,000+ clients)
() Every hour (Recommended for 20,000+ clients)

() Configure manually later

T
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10.

Choose whether or not to create login/logout hooks, and then click Continue.

Login/logout hooks enable you to schedule management tasks to take place automatically when users log
in or out of a computer. For more information on login/logout hooks, see the “Configuring the Computer
Management Framework” section.

Warning: Creating login/logout hooks with the Casper Suite overwrites existing login/logout hooks.

1SS Setup Assistant

Management

Do you want to create login/logout hooks for computers?

Login/logout hooks enable you to trigger a number of events at login/logout. These events include running
Policies, applying user-level Managed Preferences, and logging user name and IP address.

Warning: Creating login/logout hooks using the Casper Suite will overwrite login/logout hooks that currently
exist on client computers.

() Create login/logout hooks

%) Do not create login/logout hooks

If you chose to create login/logout hooks in the previous step, choose whether or not to enable Managed
Preferences and click the Continue button.

Enabling Managed Preferences allows you to set locked preferences for groups of users across your
network. You may be familiar with these preferences as MCX settings. For more information on Managed
Preferences, see the “Managed Preferences” section.

Warning: The Casper Suite’s Managed Preferences may conflict with MCX settings provided from
another source, such as Open Directory or Active Directory.

JSS Setup Assistant

Management

Do you want to enable Managed Preferences (MCX)?

The Casper Suite can provide Managed Preferences to clients. You can change this option later in the JSS using
the Management Framework Settings.

Warning: The Casper Suite's Managed Preferences can conflict with MCX settings provided from ancther source
such as Open Directory or Active Directory.

@ Enable Managed Preferences in the J5§

() Do not enable Managed Preferences in the JS§
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11.  Verify your settings, and then click the Save button.
If you need to make changes, click the Back button or make changes in the JSS.

JSS Setup Assistant

Activation Code Account Management Complete

Verify Settings

Make sure the settings below are configured correctly, and then click the Save button.
Use the Back button to make changes, if necessary, or make changes in the J55 after your session is complete.

Organization: JAMF Software, LLC
License Type: Trial
License Expires: Friday, November 26 2010
Product: Casper Suite
Licensed for: 20 clients

Update Inventory of Mobile Devices: Once every day

Update Inventory of Computers: Once every week
Check for Policies: Every 15 minutes
Login/Logout Hooks: Disabled

12.  Click the Go to the JSS button to start using the JSS immediately, or use the links to configure additional
settings for client and mobile device management in a separate browser window.

JSS Setup Assistant

Activation Code Account Management Complete

Your session in the JSS Setup Assistant is complete!

There are a few additional settings that you may want to configure before using the J55. Use the links below
to configure these settings in a separate browser window, or click the Go to the J5§ button to begin using the
J55 immediately.

Create a web server certificate...

You can create a web server certificate for Tomcat to use for S5L. This allows Mobile Devices
to communicate with the JSS. If you are getting an SSL certificate from an internal CA or a third
party Issuer, you can skip this step.

Connect to an LDAP server...

A setup assistant walks you through the process of integrating the JSS with an LDAP server, allowing
you to access user and group information directly from your organization's central database.

Enable email notifications...
Configure an SMTP Server to host email notifications when various events occur.

Upload Push Notification Certificate...
Upload your Apple Push Notification Certificate for Mobile Device Management.

Specify your SCEP Server or Set up a Built-in Certificate Authority...

Enter information about your SCEP server and create a signing certificate for enrolling Mobile Devices.
If you do not have a Certificate Authority/SCEP server, you can instruct the JSS to act as your CA.

Enable Change Management...
Set up a local log or Syslog server to track infermation about the changes made in the JSS.

Integrate with Apple's Global Service Exchange (GSX)...
Automatically populate warranty and purchasing information from GSX.

Go to the JSS




10.

11.

Upgrading the JSS

This section explains how to upgrade the JAMF Software Server (JSS) on Mac OS X Server.

To upgrade the JSS:

Back up the current database using the JSS Database Utility. (See “Backing Up the Database” for complete
instructions.)

Back up custom reports.

If you used the JSS Installer to install the JSS on Mac OS X Server, custom reports are located in /
Library/JSS/Tomcat/webapps/ROOT/WEB-INF/reporting/.

If you did not use the JSS Installer to install the JSS on Mac OS X Server, custom reports are located in /
Library/Tomcat/webapps/ROOT/WEB-INF/reporting/.

Copy the most current version of the JSS Installer for Mac to the server.

Note: The JSS Installer for Mac included in the product DMG (JSS Installer.mpkg)is unsigned.To
obtain a signed version of the JSS Installer for Mac (JSS Installer.pkg), contact JAMF Software
Support. The signed version allows you to install or upgrade the JSS when Apple’s Gatekeeper feature is
set to only allow applications downloaded from the Mac App Store and identified developers.

Double-click the installer and click Continue.

When the Introduction pane appears, click Continue.

Read the information on the Read Me pane, and then click Continue.
Select a drive on which to install the software, and then click Continue.

If the Database pane appears, enter information about your MySQL database. Then, click Continue.
The JSS Installer uses this information to connect to the existing database.

Note: This pane is only displayed if the database . xml file is in a custom location or contains invalid
information.

Click Install.
Enter your administrator password when prompted, and then click OK.

When the upgrade is complete, follow the instructions on the Summary pane to access the JSS. Then, clic
Close.

k
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Changing the Activation Code

Every time you receive a new activation code, it must be updated in the JAMF Software Server (JSS).

When you update the activation code, you can also update your company name and view the following
licensing information:

Product—Product you are licensed for

Licenses—Current number of licenses

License Renewal Date—Date the maintenance contract expires

License Type—Commercial, education, trial, etc.

To change the activation code:

Log in to the JSS with a web browser.
Click the Settings tab.

Click the General Settings link.

Enter the new activation code in the Activation Code field and click Save.
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6.

Backing Up the Database

The JSS Database Utility allows you to create backups of the jamfsoftware database, schedule database
backups, and stop scheduled database backups.

Creating Database Backups

Use the JSS Database Utility to create a backup of the jamfsoftware database. The time it takes to create
the backup depends on the size of the database.

To create a database backup:

Open the JSS Database Utility, located in:
/Library/JSS/bin/JSSDatabaseUtil. jar

Enter the username and password for an administrator account to the server, and then click OK.

If the JSS Database Utility is unable to locate the MySQL binary, you are prompted to enter the path. Click
Continue and enter the location of the binary.

If the Database Connection Setup pane appears, edit the settings to match your database configuration
and click Apply Settings.

Click Save Backup Now.

a0n JSS Database Utility

Back Up/Restore Now

Save a backup of your )55 database. | Save Backup Now... |

Restore an existing backup of your )5S database. | Restore Backup Now... |

Schedule Backups
|| schedule automatic backups for | Midnight
Save backups to:

[Library/)55/Backups/Database Change...

Delete backups older than 7 Days

Select the location where you want to save the backup, and then click Choose.

The JSS Database Utility creates the backup and saves it as a .sql.gz file.
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Scheduling Database Backups

Use the JSS Database Utility to schedule daily backups of the jamfsoftware database. You can also
automate the deletion of scheduled backups that are older than a certain number of days.

To schedule database backups:

Open the JSS Database Utility, located in:
/Library/1SS/bin/JSSDatabaseUtil. jar

Enter the username and password for an administrator account to the server, and then click OK.

If the JSS Database Utility is unable to locate the MySQL binary, you are prompted to specify the path. Click
Continue and specify the location of the binary.

If the Database Connection Setup pane appears, edit the settings to match your database configuration
and click Apply Settings.

Select the Schedule automatic backups for checkbox and choose the hour of the day that you want
backups to occur.

To change the location where backups are saved, click the Change button and select a new location.

80N JSS Database Utility

Back Up/Restore Now

Save a backup of your J55 database. | Save Backup Now... |

Restore an existing backup of your )55 database. | Restore Backup Now... |

Schedule Backups
(¥ Schedule automatic backups for | Midnight )l
Save backups to:

JLibrary/JS5/Backups/Database | Change...

[_] Delete backups older than | 7 Days gl

To automate the deletion of scheduled backups, select the Delete backups older than checkbox. Then,
choose the number of days after which backups should be deleted.

The JSS Database Utility saves daily backups at the hour that you specified. It also deletes scheduled
backups older than the number of days that you specified.

Stopping Scheduled Database Backups

Use the JSS Database Utility to stop scheduled backups of the jamfsoftware database.
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To stop scheduled database backups:

Open the JSS Database Utility, located in:
/Library/3SS/bin/JSSDatabaseUtil. jar

Enter the username and password for an administrator account to the server, and then click OK.

If the JSS Database Utility is unable to locate the MySQL binary, you are prompted to enter the path. Click
Continue and enter the location of the binary.

If the Database Connection Setup pane appears, edit the settings to match your database configuration
and click Apply Settings.

Deselect the Schedule automatic backups for checkbox.

8.00 JSS Database Utility

Back Up/Restore Now

Save a backup of your )5S database. | Save Backup Now... |

Restore an existing backup of your )55 database. | Restore Backup Now... |

Schedule Backups

(¥ schedule automatic backups for | Midnight Ll
Save backups to:
/Library/)S5/Backups /Database \ Change...
|| Delete backups older than | 7 Days il

The JSS Database Utility stops scheduled backups immediately.
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7.

Restoring Database Backups

If you need to revert to an earlier version of your database, you can use the JSS Database Utility to restore

a database backup.

To restore a database backup:

Open the JSS Database Utility, located in:
/Library/3SS/bin/JSSDatabaseUtil. jar

Enter the username and password for an administrator account to the server, and then click OK.

If the JSS Database Utility is unable to locate the MySQL binary, you are prompted to enter the path. Click

Continue and enter the location of the binary.

If the Database Connection Setup pane appears, edit the settings to match your database configuration

and click Apply Settings.

Click Restore Backup Now.

800 155 Database Utility

~Back Up/Restore Now

Save a backup of your )55 database. \ Save Backup Now...

Restore an existing backup of your )5S database. \ Restore Backup Now...

~Schedule Backups

| | Schedule automatic backups for | Midnight o

Save backups to:
/Library/)55/Backups/Database Change...

Delete backups older than 7 Days

Select the backup that you want to restore (.sql or .sgl.gz), and then click Choose.

When prompted to restart Tomcat, click Yes.
ann 155 Database Utility

Would you like the JSS Database Utility to restart Tomcat?

jss

| No |[Yes

J

The JSS Database Utility restarts Tomcat and replaces the current database with the one that you restored.
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Deleting Logs from the Database

Over time, the JAMF Software Server (JSS) accumulates a large number of logs. Deleting these logs can
reduce the size of the database and can speed up searches.

You can schedule log deletion to take place automatically or manually delete logs as needed.

To schedule automatic log deletion:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Flush Database Logs link.

Use the pop-up menus to specify the period of time after which logs will be deleted.

For example, to delete Policy logs that are six months old or older, choose “Six Months” from the pop-up
menu next to Policy Logs.

To stop deleting a type of log, choose “Do not delete” from the pop-up menu next to it.

Flush Database Logs

Flush Database Logs

Logs that are older than the times specified will be automatically deleted from the JSS at the time specified.
The J5S will not delete the last inventory report for a computer or mobile device even if it is older than the time specified.

Casper Imaging Logs: | Do not delete * |

Casper Remote Logs: | po not delete * |

Policy Logs: | po not delete ¢ |

CasperVNC Logs: | ponotdelete ¢ |

Computer Inventory Reports: | g not delete + |
Computer Usage Logs: | pg not delete + |

Mobile Device Inventory Reports: [ pg not delete & |
J

Mobile Device Management Command Logs: | po not delete *

Time of Day: | widnight + |

| Flush Manually | | cancel | | save |

Use the Time of Day pop-up menu to schedule a time for the deletion.
For example, to delete logs every morning at 2 a.m., choose “2 AM" from the pop-up menu.

Click Save.

Click Continue to confirm the schedule.

To delete logs manually:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Flush Database Logs link.
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5.

Click the Flush Manually button.

Select the types of logs you want to delete.

Mass Delete Logs

Logs to Delete: (| Casper Imaging Logs
[_ICasper Remote Logs
[IPolicy Logs
("I CasperVNC Logs
["IComputer Inventory Reparts
[_IComputer Usage Logs
["IMobile Device Inventory Reports
[_IMabile Device Management Command Logs

Older than: | One Week  + |

| Cancel | | Delete |

Use the Older than pop-up menu to specify the period of time after which logs will be deleted.
For example, to delete logs that are six months old or older, choose “Six Months” from the pop-up menu.

Click Delete.

Click Continue to confirm the results.
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Migrating to Another Server

The instructions in this section explain how to migrate the JAMF Software Server (JSS) to another server.

To migrate the JSS:

Back up the existing jamfsoftware database using the JSS Database Utility. (See “Backing Up the Database”
for detailed instructions.)

Ensure that the new server meets the requirements for the JSS Installer. Then, follow the instructions in
“Installing the JSS” to install the required software (if needed) and create the jamfsoftware database.

Copy the JSS Installer to the new server.

Install the JSS by launching the installer and following the onscreen instructions. (See “Installing the JSS”
for detailed instructions.)

Copy the database backup to the new server, and then use the JSS Database Utility to restore the backup.
(See “Restoring a Database Backup” for detailed instructions.)

Regenerate the web server certificate. (See “Generating a Web Server Certificate” for detailed instructions.)

Update the DNS entry to point to the new server’s IP address.

Note: If you can’t change the DNS entry, you must change the JSS URL and re-enroll all mobile devices
and computers.
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Managing Distribution Points

A key feature of the Casper Suite is the ability to deploy packages from multiple distribution points. This
allows you to deploy packages to computers in other locations using servers that are geographically
close to each destination. It reduces the need for bandwidth between locations and allows you to deploy
packages across a widespread network.

Distribution points can share files over Apple Filing Protocol (AFP) or Server Message Block (SMB).

This section explains how to:
= Add distribution points
= Replicate distribution points

= Replicate FireWire or USB drives

Adding Distribution Points

Servers running any platform can function as distribution points.

Adding a distribution point involves the following steps:
Set up the distribution point.

Add a record of the distribution point to the JAMF Software Server (JSS).

Step 1: Set Up a New Distribution Point

Create a share point (AFP or SMB) on the server you want to utilize as the distribution point.
Create an account that has read-only access to the share.

Create an account that has read/write access to the share.

Make sure “Everyone” has read-only access to the share.

(Optional) Enable HTTP or HTTPS on the share point.

Step 2: Add a Record of the Distribution Point to the JSS
Log in to the JSS with a web browser.

Click the Settings tab.

Click the Servers link.

Click the Add Server button in the toolbar.

Select the Distribution Point option and click Continue.

Enter a display name for the server.
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Enter the DNS name or IP address for the server.

To use this server as the default distribution point, select the Use this server as the Master option.

To assign a backup distribution point, choose a server from the Failover Distribution Point pop-up menu.

Click the File Sharing tab and enter information about the AFP or SMB share point.
Casper Imaging uses the read-only account to mount the share.

Casper Admin uses the read/write account.

Edit Distribution Point: NYC

General

File Sharing

HTTP

Connection Type:

Share Name:

CasperShare -MyShare

Workgroup or Domain (SME only): |

Port:

[543

Verify Read-Only Password: |

Read -Only Username:

Read-Only Password: |

casperinstall
--------

Verify Read/Write Password:

Read /Write Username:

Read/Write Password:

|casperadmin

(Optional) Configure the distribution point to use HTTP downloads.
This requires HTTP or HTTPS access to be enabled on the distribution point server.

a. Click the HTTP tab.

Edit Distribution Point: NYC

General

File Sharing

@
HTTP

] HTTP Downloads are enabled for this Distribution Point

Protocol:

Port: |80

Context |

® No Authentication is Required

() Username & Password Authentication is Required

Username:

Password: |

Verify Password: |

() Certificate Authentication is Required

Certificate: None Chosen

Choose File...
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12.

b. Select the HTTP Downloads are enabled for this Distribution Point checkbox.
Choose “HTTP” or “HTTPS” from the Protocol pop-up menu.
d. Enter the portin the Port field.

e. Inthe Context field, enter the path to the share point (following the DNS name or port) that exists in
the URL. For example, you would type“CasperShare”if the share is accessible at:

http://192.168.10.10/CasperShare/

f. If the share requires a username and password to access files, select the Username & Password
Authentication is Required option. Enter the username and password, and then enter the password
again to verify it.

g. Ifthe share requires a certificate, select Certificate Authentication is Required and click Choose File to
upload the certificate.

The certificate that you upload must be trusted.

Click the Save button.

Replicating Distribution Points

You can replicate distribution points that are running on any platform.

To ensure distribution points have the same deployable items, synchronize them manually using the
Casper Admin application.

To replicate distribution points:
Open Casper Admin.

Select the distribution point(s) you want to replicate and click the Replicate button.

Replicating FireWire or USB Drives

To make packages, scripts, printers, and configurations available for Casper Imaging offline, replicate to an
external drive and place a copy of Casper Imaging at the root of the drive.

Note: Casper Imaging cannot create a management account when imaging offline.

Replicating a FireWire or USB drive involves the following steps:
Replicate to an external drive.

Use the replicated drive offline.

Step 1: Replicate to an External Drive
Open Casper Admin.

Drag the hard drive icon from the Finder to the sidebar in Casper Admin.
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If the external drive is already under the Local Drives heading in the sidebar, it is already replicated and is
mounted automatically when you open Casper Admin.

Select the drive in the sidebar and click the Replicate button.

Step 2: Use the Replicated Drive Offline
Make a copy of the Casper Imaging application.

Put the copy at the root of the replicated drive at the same level as the Packages, Scripts, and Casper Data
folders.

Open Casper Imaging.
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Enabling Email Notifications

In order for the JAMF Software Server (JSS) to send email notifications, you must specify the SMTP server
from which the notifications will be sent.

Email notifications can be sent when the following events occur:
= A computeris acquired using a PreStage.

= An error occurs during the imaging or Autorun process.

= An error occurs while a policy is being executed.

= ASelf Healing event takes place.

= Restricted software is found.

= Alicensing violation occurs.

= A smart computer group changes.

= Thereis a JSS service restart.

= Adatabase is backed up successfully.

= A database backup fails.

This section explains how to set up and modify an SMTP server.

To set up or modify an SMTP Server:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the General Settings link.

Click the SMTP Server tab.

Enter the DNS name or IP address for the SMTP server in the SMTP Host Address field.

i) - = () @
Activation Code SMTP Server Change Management GSX Connection Server Configuration
SMTP Server

By specifying an SMTF server, the J55 can send email notifications to users of the J55.

SMTP Host Address:

Encryption Method: | None B‘

Port: 25 L]

Connection times out in: 5 seconds

Send notifications from this email address:

Requires Authentication: [

No email address is associated with admin to send a test message o




6. Use the Encryption Method pop-up menu to specify the protocol used for data encryption.

7. Inthe Port field, enter the port over which the connection is made.

The default port is 25.

8. Enter the number of seconds you want to wait before the connection times out.

By default, this is 5 seconds.

9. Enter the email address from which notifications will be sent.

10. If the SMTP server requires authentication, select the Requires Authentication checkbox and enter

credentials for a valid account to the server.

J55 Settings

i ] B = L)

Activation Code SMTP Server change Managcment CS% Connectlo”

0
Server Configuratio”

SMTP Server

Ry spreibyicg as SMTP senver, the Ji5 rar send email netificaticone ta users o the 55

SMTP Host Address:
Enesyntion Method: f M 5‘
Port |2 L]

‘Conmection times outin |5 seConds

Send notifications from this emall address:
Requires Authentication:

Username:

Password:

Verify Password: [

Nev el afieis (s assofated with sodecan o send A fet message m

(Cancel ) ( Sawe

11. If you want to send a test message, click the Send Test message to <email address> link.

The JSS sends this message to the email address for the account currently logged in to the JSS.

12. Click Save.
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Enabling Change Management

Change management logs allow you to track the following information:
= Changes made to the client computers on your network
= Computers from which the changes were made

= Accounts that initiated the changes

You can choose to write these logs to a local log on the server running the JAMF Software Server (JSS) or a
Syslog server.

The header for each logged event includes the following information:
= Timestamp (when the event took place)

= Username of the account that initiated the change

= |P address of the client computer that triggered the event

= JSSidentifier (com. jamfsoftware. jss)

This section explains how to set up and modify change management to a log file and a Syslog server.

To set up or modify change management to a log file:
Log in to the JSS with a web browser.

Click the Settings tab.

Click the General Settings link.

Click the Change Management tab.

Select the Enable Change Management checkbox if it is not already selected, and enter a directory
location for the log file.

(i ] s ] (£ @

Activation Code SMTP Server Change Management GSX Connection Server Configuration

Change Management
The J5S can be configured to log all changes to a log file or a Syslog server.
# Enable Change Management
Log Directory: /varflag

Size of Log File (MB): 10

Syslog Daemon Definitions
Hostname:

Port (Default is 514): 514
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Click Save.

Change Management logs are written to the file specified in the Log Directory field. They have the
filename jamfChangeManagement. l1og and can be viewed using the Console application.

To set up or modify change management to a Syslog server:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the General Settings link.

Click the Change Management tab.

Select the Enable Change Management checkbox.

In the Hostname field, enter the DNS name or IP address for the Syslog server.

Enter the UDP port that the Syslog server is using.
The port is entered as 514 by default.

i ] = ] L} @

Activation Code SMTP Server Change Management GSX Connection Server Configuration

Change Management
The ]SS can be configured to log all changes to a log file or a Syslog server.
¥ Enable Change Management
Log Directory: jvarflog

Size of Log File (MB): |10

Syslog Daemon Definitions
Hostname: syslog.mycompany.co

Port (Default is 514); 514

Click Save.
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Integrating with GSX

The JAMF Software Server (JSS) can access the following purchasing information from Apple’s Global
Service Exchange (GSX) for computers in the JSS:

= Purchase date
= Warranty expiration date

= Apple Care ID (Warranty reference number)

To set up a GSX connection, you must have a GSX account and be signed up for Apple’s Self-Servicing
Account (SSA) Program. Information on this program is currently available at:

https://www.apple.com/support/programs/ssa/

For information on setting up a GSX account for integration with the JSS, see the following Knowledge
Base article:

https://jamfnation.jamfsoftware.com/article.html?id=26

Note: GSX may not always return complete purchasing information for a computer. The JSS displays any
information that is returned.

This section explains how to set up and modify the GSX connection.

To set up or modify the GSX connection:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the General Settings link.

Click the GSX Connection tab.

Select the Enable connection to GSX checkbox.
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Enter your GSX account number in the GSX Account Number field.

i} u ] ) LY

Activation Code SMTP Server Change Management GSX Connection Server Configuration

GSX Connection
The J55 utilizes Apple’s Global Service Exchange to lookup warranty information for Apple hardware.
¥ Enable connection to GSX
GSX Account Number:
Username:
Password:

Verify Password:
Choose Region: | Americas ™
Date Format: MonthDayYear

© Test the connection at gsxws2.apple.com/gsx-wsservices/amfasp

Cancel Save

Enter the username and password for your GSX account, and then enter the password again to verify it.

Choose your region from the Choose Region pop-up menu.
The date format automatically updates to reflect the region you choose.

To test the GSX connection, click the Search &5 icon.

The JSS attempts to connect to GSX with the account number and credentials that you provided. A
message displays confirming the success or failure of the connection.

Click Save.



Generating a Web Server Certificate

The JAMF Software Server (JSS) requires a valid web server certificate to ensure that computers and
mobile devices communicate with the JSS and not an imposter server.

If you already have a web server certificate from an internal certificate authority (CA) or a trusted third-
party vendor, follow the vendor’s instructions for using the certificate with Tomcat.

If you do not have a valid web server certificate, you can generate one from the CA that is built into the
JSS.To do this, the JSS must be installed as the “"ROOT” web application and the user running the Tomcat
process must have read/write access to Tomcat’s server. xml file.

To generate a web server certificate from the built-in CA:
Log in to the JSS with a web browser.

Click the Settings tab.

Click the General Settings link.

Click the Server Configuration tab.

Click the Replace with certificate from the JSS’s built-in CA link.

0 . = [) @
Activation Code SMTP Server Change Management GSX Connection Server Configuration
Tl website Certificate © Clustering Tomeat Configuration “ Limited Access )5S

Tomcat Web Server Certificate

To ensure secure communication with the JS5, you need to have a valid web server certificate installed.
This certificate can come from a trusted third party vendor, your internal certificate authority, or from
the built-in certificate authority in the J55.

Mote: The JSS will modify Tomcat's server.xml file when you make these changes. You will need to restart
Tomcat before the new certificate will be utilized.

SSL Certificate: CN=phineas.jamfsw.corp, OU=)5S, O=JAMF Software, L=Minneapalis, ST=MN, C=US
Issuer: CN=My Company )5S Built-in Certificate Authaority

Replace with certificate from the J55's built-in CA

Click Save.

Restart Tomcat to begin utilizing the certificate.
For instructions on how to restart Tomcat, see the Knowledge Base article at:
https://jamfnation.jamfsoftware.com/article.htmi?id=117
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Enabling Clustering

Clustering allows you to point multiple instances of the JAMF Software Server (JSS) web application to the
same database. This requires a load balancer with the address of the JSS. For example:

https://jss.mycompany.com:8443/
The load balancer should route traffic to the servers running the web application.

The web application that functions as the master handles the following tasks:
= Upgrading the database schema
= Flushing database logs

For more information on setting up a clustered environment, contact your JAMF Software
Representative.

To enable clustering:
1. Login to the JSS with a web browser.
2. Click the Settings tab.
3. Click the Generals Settings link.
4. Click the Server Configuration tab.
5. Click the Clustering tab.

6. Select the Enable Clustering checkbox.

i) B -] ] ©
Activation Code SMTP Server Change Management GSX Connection Server Configuration
Tl website Certificate % Clustering Tomcat Configuration “ Limited Access JSS

JSS Web Application Clustering

You can configure multiple instances of the JS5 web application to point to the same database.
You must have a load balancer with the address:

https: f /phineas.jamfsw.corp:8443/
The load balancer should route traffic to the servers running the web application.
The web application that is flagged as the master will be responsible for upgrading the database

schema, flushing database logs, sending MDM notifications for inventory updates and calculating
smart group updates.

[ Enable Clustering

7. To add web applications to the cluster, click the Add To Cluster links.
8. To make a web application the master, click the Master link.

9. Click Save.
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10.

Restart Tomcat for the changes to take effect.
For instructions on how to restart Tomcat, see the Knowledge Base article at:
https://jamfnation.jamfsoftware.com/article.html?id=117
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Configuring Tomcat to Work with a Load
Balancer

When working with a load balancer, you may need to enable a few attributes in Tomcat's server . xml file
to ensure that Tomcat and the load balancer communicate properly.

The JAMF Software Server (JSS) allows you to enable the following attributes without requiring you to
access the server. xml file manually:

= Remote IP valve
= Proxy port

= Proxy scheme

To enable these attributes, the JSS must be installed as the “ROOT” web application and the user running
the Tomcat process must have read/write access to Tomcat’s server. xml file.

To configure Tomcat to work with a load balancer:
Log in to the JSS with a web browser.

Click the Settings tab.

Click the General Settings link.

Click the Server Configuration tab.

Click the Tomcat Configuration tab.

Click the Configure link across from an attribute to enable it.

i) = -] 2 &
Activation Code SMTP Server Change Management G5X Connection Server Configuration
Tl website Certificate © Clustering Tomeat Configuration © Limited Access J55

Tomcat Configuration

When Tomcat is behind a load balancer, there are some changes that are often necessary to
ensure that communication works as expected. You can enable the most common items here.

Mote: The J55 will modify Tomcat's server.xmil file when you make these changes. You will need to restart
Tomcat before the changes will take effect. This needs to be done on every server in the cluster.

‘Option Status
@ Remote IP Valve Configured  Already Configured
@  Proxy Port  Not Configured  Configure...
@ Proxy Scheme Not Configured  Configure...

Click Save.

Restart Tomcat for the changes to take effect.
For instructions on how to restart Tomcat, see the Knowledge Base article at:
https://jamfnation.jamfsoftware.com/article.html?id=117
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Changing the Limited Access Setting

When working in a clustered environment, you may have a JAMF Software Server (JSS) that computers
and mobile devices can access from outside of the network. If you have a second JSS web application
that resides in your DMZ, you can make the administrative interface unavailable by changing the Limited
Access setting. Changing this setting also limits the types of devices that can check in and enroll with the
JSS.

The Limited Access setting has four options:

= Full JSS—This is the default option for every JSS. It allows computers and mobile devices to check in
and enroll with the JSS and use Self Service. It also makes the JSS interface available from anywhere.

= Computer and Mobile Device Management—This option allows computers and mobile devices to
check in and enroll with the JSS and use Self Service. It also disables the JSS interface.

= Computer Management Only—This option allows computers to check in with the JSS and use Self
Service. It also disables the JSS interface.

= Mobile Device Management Only—This option allows mobile devices to check in and enroll with the

JSS and use Self Service. It also disables the JSS interface.

Warning: Do not change the Limited Access setting while connecting through a load balancer. Connect
directly to the instance of Tomcat that is inside of your DMZ.

After you change the Limited Access setting, the JSS interface is inaccessible. To make additional changes,

you need to manually modify the web . xm1 file. If you need to revert the JSS to the default setting (Full
JSS), delete theweb . xm1 filein /Library/JSS/Tomcat/webapps/ROOT/WEB-INF/ and rename
theweb.xml.original filetoweb.xml.

Note: If you upgraded from v8.1 or earlier, the web . xm1l and web . xm1 .original files are located in
/Library/Tomcat/webapps/ROOT/WEB-INF/.

Upgrading the JSS automatically resets the Limited Access setting to Full JSS. You will need to change this

setting every time you upgrade.

To change the Limited Access setting:

Use a web browser to log in to the desired instance of the JSS.
Click the Settings tab.

Click the General Settings link.

Click the Server Configuration tab.

Click the Limited Access JSS tab.
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6. Select alimited access option.

0o = ] o ©

=
Activation Code SMTP Server Change Management GSX Connection

Server Configuration

Il website Certificate % Clustering Tomcat Configuration ‘ “ Limited Access JSS ‘

Limited Access JSS

If this instance of the J55 sits inside your DMZ, you can limit the functienality that this JS5 provides.
Mote: The J55 will modify its web.xml file when you make these changes. You will need to restart the

155 before the changes will take effect. If you disable the Full J55, you will no longer be able to access this
interface and will need to make additional changes to web.xml by hand.

Warning: You should only change this setting when connecting directly to the instance of Tomcat
that is inside your DMZ. You should not change it while connecting through a load balancer.

@ Full 55

() Computer and Mobile Device Management
() Computer Management Only

) Mobile Device Management Only

7. Click Save.

8. Restart the JSS for any changes to take effect.
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Frequently Asked Questions

Q. What is installed on Mac OS X Server when | install the JSS?

A.The following files and folders are installed on Mac OS X Server:

Apache Tomcat
Tomcat is the web application server that runs the JSS web application. A directory named Tomcat is
installed in:

/Library/J]SS/Tomcat/
CasperShare

The distribution point created by default for a fresh installation. The JSS Installer creates a directory named
CasperSharein:

/Shared Items/CasperShare/

com.jamfsoftware.tomcat.plist

This is the launchd item that controls Tomcat. It is installed and loaded in the following location:
/Library/LaunchDaemons/com. jamfsoftware.tomcat.plist

Database backup location

The JSS Database Utility stores database backups in the following location by default:
/Library/J]SS/Backups/Database/

JSS Database Utility

The JSS Database Utility is installed in the following location:
/Library/31SS/bin/JSSDatabaseUtil. jar

JSS web application

The JSS is a web application that runs on Tomcat. A directory named ROOT is installed in:
/Library/]SS/Tomcat/webapps/RO0T/

keystore

Tomcat requires a .keystore file to provide connections over SSL. The JSS Installer creates a default
.keystore file and stores it in the following location:

/Library/J]SS/Tomcat/.keystore

Logs
Logs for the installation and for the JSS are stored in the following directory:

/Library/J]SS/Logs/
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server.xml

The JSS Installer installs a modified copy of Tomcat's server . xml file. This file enables SSL, ensures
that the JSS appears in the root context, and enables database connection pooling. It is installed in the
following location:

/Library/]SS/Tomcat/conf/server.xml

Note: The locations of these files and folders are different if you upgraded from v8.1 or earlier and your
JSSiis installed on OS X Server v10.6. Apache Tomcat and its related files are stored in
/Library/Tomcat/ and the JSS web application (previously known as the jamf web application) is
storedin /Library/Tomcat/webapps/R0O0T/.

Q. Can |l install the JSS on other platforms?

A. Yes. You can install the JSS on any platform that supports the following software:
= Javal.6

= MySQL 5.1 or later

= Apache Tomcat 6.0 or later

Tested operating systems include:

= (OSXServerv10.7

= OSXServerv10.6

= Ubuntu 10.04 LTS Server

= Red Hat Enterprise Linux (RHEL) 6
= Windows Server 2008

Although you can install the JSS on any server that meets the minimum requirements, JSS Installers are
only available for Mac, Linux, and Windows.

To obtain the JSS Installers for Linux and Windows and their documentation, see the introductory email
that you received from JAMF Software or contact your JAMF Software Representative.
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Troubleshooting the JSS

Most issues with the JSS have to do with the configuration of Apache Tomcat or MySQL. The JSS Database
Utility allows you to troubleshoot most of the issues that you encounter.

This section explains how to troubleshoot the following issues:
= Connection issues
= Memory issues

= Database issues

Connection Issues

If applications are not connecting to the JAMF Software Server (JSS), you can use a web browser to
troubleshoot the issue. If you are able to connect to the JSS, the applications should be able to connect as
well.

To troubleshoot connection issues:

Open a web browser and try connecting to the JSS on port 8443.
For example, if the DNS name of the JSS is “jss.mycompany.com”, try connecting to:
https://jss.mycompany.com:8443/

If you are prompted to verify a certificate, accept the certificate.

If you are able to connect to the JSS, make sure that the application is pointing at the correct IP address.
a. Quit the application.

b. Hold down the Option key and re-open the application to bring up the Preferences pane.

c.  On the Preferences pane, enter the DNS name or IP address for the JSS and then click Save.

d. Enter the username and password for an administrator account to the server, and then click OK.

If the application still fails to connect, restart Tomcat.
For instructions on how to restart Tomcat, see the Knowledge Base article at:
https://jamfnation.jamfsoftware.com/article.html?id=117
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1.

Memory Issues

If there is a large amount of data in the JSS, you may need to allocate additional memory to Tomcat.
Tomcat displays the following error page if more memory is required:

) € Apache Tomcat/4.1.29-LE-jdk14 — Error report —
(< ][ + )] e 1227.0.01:9006/searchmppticatonsz-nem OF(a- cosge

HTTP Status 500 -

[T:Z Exception report
message
EIETI Y The server encountered an internal error () that prevented it from fulfilling this request.

let ion: Serviet ion threw an
: iy

nalDoFilter (Applica
ter (ApplicationPilt

ApplicationFilterC!

ipeli ipelineVa:
ipeline.invoke (

ine.java:643)

a:995)

lve.invoke( lve.java:191)

ipeli ineva: .
es.CertificatesvValve.invoke (CertificatesValve.java:246)
ipeli ipelineVa: et

ipeline.invoke (

1ve.java:172)

. dpipeline.java:641)
ipeline.java:480)
. java:

lve.java:174)

dpipeline.java:643)

at ipeline.invoke ( a:480)
at ke inerB.
at . i
p1l.Ettpll .process (Httpll: . :781)
at tp11.HttpllProtocolsHttpll +ionHandl ion(HttpllProtocol.java:549)

It (Poo int.java:589)
.ThreadPool§ControlRunnable .run(ThreadPool.java:666)
2)

For instructions on viewing the amount of memory being used by the web application and allocating
additional memory to Tomcat, see “Allocating Additional Memory to Tomcat”.

Database Issues

MySQL database tables can become corrupt if the JSS is running on a very slow computer to which many

clients are connected, or if the server running the JSS crashed and the database was not shut down

properly.

When errors occur in the MySQL database, the JSS displays an alert similar to the following:

Got error 127 from table handler

This section explains how to:
= View the status of database tables
= Repair database tables

= Optimize database tables

Viewing the Status of Database Tables

To view the status of database tables:

Log in to the JSS with a web browser.
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Click the Settings tab.
Click the Database/Web Application Health link.

Click the Database Table Status link.

Repairing Database Tables

If you have a large database, it may take longer to verify the status of your database tables. Once the status
of each table is returned, you may want to repair the tables that do not return an “OK” status.

To repair database tables:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Database/Web Application Health link.
Click the Repair Database Tables link.

Optimizing Database Tables

Optimizing database tables allows you to ensure that each table’s index is up to date so that you can
perform database lookups as quickly as possible.

To optimize database tables:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Database/Web Application Health link.

Click the Optimize Database Tables link.
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Chapter 2: Client Management
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‘ Building Packages

Introduction to Composer

A package is a self-contained group of files that can be deployed to remote computers or as part of the
imaging process. A package consists of product or component files, such as an application and its required
components, a set of fonts, a preference file, or a document. A package also contains instructions about
how and where it should be installed once received by the user.

Depending on the files you want to package, Composer allows you to monitor the installation of your
software or use files that already exist on your hard drive to create a package source.

You can create a package source using the following methods:

Take before and after snapshots of your hard drive.
Monitor the file system.

Use pre-installed software.

Use user environment settings.

Drag contents from the Finder into Composer.

Use an existing package.

After you verify the contents of a package source, Composer gives you the option to build a PKG or a DMG
based on how you intend to use and deploy the package.

Composer also allows you to build a DMG of a pre-configured operating system.
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Creating Package Sources

A package source allows you to view and edit attributes of the package (such as files, scripts, permissions,
and localizations) before it is built. Once a package source exists for a group of files, you can make
modifications and build the package as many times as necessary.

You can create a package source using the following methods:

= Snapshots—Composer takes before and after snapshots of the file system and creates a package
source based on the changes. This method allows you to monitor installations in all locations on the
drive. If necessary, you can also quit Composer or log out/reboot during the installation process.

= File system monitoring—Composer uses the File System Events (FSEvents) framework to monitor
any changes that are made to the file system during the installation process. Then, Composer creates
a package source based on the changes. This method does not allow you to quit Composer or log in/
reboot during the installation process. In addition, an excess of file system activity can cause FSEvents
to miss changes.

= Using pre-installed software—You can use software that is pre-installed on your computer to create
a package source based on package manifests. This method allows you to create package sources
without monitoring the installation process.

= Using user environment settings—Package manifests can also be used to capture settings configured
on your computer, such as Dashboard, Display, and Global Preference settings.

= Dragging contents from the Finder—A simple drag-and-drop process allows you to create a package
source from files already installed on your computer.

= Using an existing package—Composer allows you to make modifications to an existing package or
convert between the PKG and DMG package formats.

This section explains how to create package sources using these six methods.

Taking Snapshots

If the files you want to package are not already installed on the drive, Composer can take a snapshot of
the file system before and after the files have been installed and create a package source based on the
changes.

Composer can take two kinds of snapshots:

= Normal snapshots—These snapshots capture any new files on the drive. These snapshots can take
anywhere from ten seconds to several minutes depending on your hardware and the number of files
on the drive.

= New and modified snapshots—These snapshots capture any new files on the drive, as well as any files
that have been modified. These snapshots can take longer than normal snapshots, since Composer
records the modifications date of each file while performing the snapshot.

There are several benefits to using the snapshot approach:

= Composer monitors installations in all locations on the drive.
= You can quit Composer during the installation process.

= You can log out or reboot during the installation process.
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= If you delete a file while making modifications to a package source, it may be possible to restore the
deleted file. For more information about restoring deleted files, see the “Editing a Package Source”
section.

To create a package source by taking snapshots:
1. Open Composer and authenticate locally.
2. Click the New button in the toolbar.

3. Under the Monitor Installation heading in the sidebar, select Snapshot.

4. Select Normal Snapshot or New & Modified Snapshot, and then click Next.

Choose a method to create your package:

i« Monitoring Installation r— "S‘ . .
e 2] (&) (W

| Operating System
Build OS Package Normal New & Modified Monitor File
& Package Manifests Snapshot Snapshot System Changes
» Pre-Installed Software
User Environment
r = ) Take a snapshot that watches for any new files on the boot drive. A
,,°_, snapshot will be taken before and after the installation process, and then
Ial the two snapshots will be compared.
—

5. Enter a name for the package and click Next.

Choose a name for your package:

Package Name I

Cancel Previous Next




Install and configure your software, and then click the Create Package Source button to initialize the

" n
after” snapshot.
8eoe Composer
e 2, /
- - <
New: Build as DMG  Build as PKG Search
SOURCES
T ) -
PACKAGES
— Perform your Installation
A Install and configure your software.
_.%\-}}\_ When you are done, click Create Package Source below.
e
(mCancol )

Monitoring the File System

When creating a package source using file system monitoring, Composer uses the File System Events

(FSEvents) framework that is built into Mac OS X to monitor any changes that are made to the file system.

Each time a change is made, FSEvents receives a notification. After your software is installed, Composer
analyzes the changes and creates a package source based on the results.

The following limitations should be taken into consideration when monitoring the file system to create a
package source:

= You cannot quit Composer during the installation process.
= You cannot log in or restart during the installation process.

= |tis possible for FSEvents to miss events if there is too much file system activity.

To create a package source by monitoring the file system:
Open Composer and authenticate locally.
Click the New button in the toolbar.

Under the Monitor Installation heading in the sidebar, select Snapshot.
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4.

5.

6.

Select Monitor File System Changes and click Next.

Choose a method to create your package:

%

| Operating System

i (=

Build OS Package

Normal New & Modified Monitor File

& Package Manifests

Snapshot Snapshot System Changes

# Pre-Installed Seftware
User Envirenment

Use Composer to monitor changes to the file system using FSEvents.
. WARNING: If an installation causes heavy enough file system activity, it is

possible that file system menitoring will miss events.

o | (Nea

Enter a name for the package and click Next.

Install and configure your software, and then click the Create Package Source button.

8o0e

PACKAGES

Choose a name for your package:

Package Name I ]

.

Composer

Perform your Installation

Install and configure your software.
When you are done, click Create Package Source below.
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Creating Package Sources from Pre-Installed Software

You can create a package source from software that is currently installed on your computer if Composer
contains a package manifest for the software.

Note: If there is software you would like added to the package manifest options in Composer, email your
recommendations to diffs@jamfsoftware.com.

This section explains how to:
= View a list of available package manifests for pre-installed software

= (Create a package source from pre-installed software

For instructions on creating package manifests, updating the package manifests available, and importing
package manifests to Composer, see “Managing Package Manifests".

To view available package manifests for pre-installed software:
Open Composer and authenticate locally.
Click New.

To view package manifests for software installed on the computer, select Pre-Installed Software.
Composer scans the file system and displays icons for the software it can package.

To view package manifests for software that is not installed on the computer, click the disclosure triangle
next to Pre-Installed Software and select Not Installed.

To create a package source from pre-installed software:

Open Composer and authenticate locally.

Click the New button in the toolbar.

Under the Package Manifests heading in the sidebar, select Pre-Installed Software.

Select the item(s) you want to create a package source from, and then click Next.

Choose a method to create your package:

i Monitoring Installation *
_ Operating System .

Build OS Package Adium Adobe Flash Shockwave CrashPlan

4 Package Manifests Player

W Fre-installed Software ) :
User Environment /
¥ @

Firefox Flip4Mac 2.1 Flip4Mac 2.4 Coogle Chrome

Wk é’& -

This is a package manifest for Firefex.

Created By JAMF Software, LLC &

| Cancel | Previous
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Creating Package Sources from User Environment Settings

You can create a package source that captures the look-and-feel of your computer’s interface, such as
Dashboard, Display, and Global Preference settings. If Composer contains a package manifest for the
setting you want to capture, you can create a package source from it.

To determine which of your current settings Composer can package, select User Environment under the
Package Manifests heading. Composer scans the file system and displays icons for the settings that it has
package manifests for.

Note: If there is a setting you would like added to the package manifest options in Composer, email your
recommendations to diffs@jamfsoftware.com.

For instructions on creating package manifests, updating the package manifests available, and importing
package manifests to Composer, see “Managing Package Manifests".

To create a package source from user environment settings:

Open Composer and authenticate locally.

Click the New button in the toolbar.

Under the Package Manifests heading in the sidebar, select User Environment.

Select the item(s) you want to create a package source from, and then click Next.

Choose a method to create your package:

i« Monitoring Installation - =
/ 1
& e S
| Operating System v - -

Build OS Package Dashboard Desktop Pattern Dock Finder
< Package Manifests Preferences
b Pre-Installed Software B N ~
g @ A n
Global Internet Config  Launch Services Login Items

Preferences

ﬁ @
is package manifest captures the dashboard of the user that is currently
Thi ka if he dashbeard of th h I
ogged in. It does not capture widgets. If you want to capture a specific
. logged in. Itd dgets. If ifi
‘\_/-‘ widget, you need to package it separately.

()

Created By JAMF Software, LLC

| Cancel | Previous

Creating Package Sources by Dragging Contents from the
Finder

If you already know which item you want to package, you can bypass the snapshot or monitoring process
by dragging items from the Finder to the Sources list in Composer.
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There are a few ways Composer handles these items:
= |ftheitem is a package (DMG, PKG, or MPKG), it is listed in the sidebar under the Packages heading.

= |ftheitem is a folder, the root of the folder is used as the root of the package if it is one of the following
directories:

/Applications/
/Developer/
/Library/
/System/
/Users/

/bin/
/private/
/sbin/

/usr/

= Any other items are copied to their current location.

Note: This is the equivalent of a PreBuilt package in earlier versions of Composer.

Creating Package Sources from Existing Packages

Composer allows you to rebuild an existing package (PKG, DMG, or MPKG) by converting it to a package
source. After converting it to a package source, you can make changes to its contents and save a new copy
of the package.

To create a package source from an existing package:
Open Composer and authenticate locally.

Drag the package you want to convert from the Finder to the sidebar in Composer.
The package will appear under the Packages heading.

Select the package, and then click the Convert to Source button.

800 Composer
% "9 (
- s €*© =

New Build as DMG _Build as PKG Search

SOURCES

PACKAGES

(S Freioxpkg

Firefox.pkg

S /Users/erinmiska/Desktop/Firefox.pkg
30.03 MB

Created Thursday, October 27, 2011 3:41:19 PM Central
Daylight Time
Modified Thursday, October 27, 2011 3:41:20 PM Central
Daylight Time
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When the conversion is complete, a new package source is listed in the sidebar under the Sources
heading.

806 Composer

¥ 9 Applications
» @ Firefox.app

» [ Library

» [ users

PACKAGES
‘@ Firefox.pkg

-

-
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Managing Package Manifests

Package manifests are .composer files that can be used to create package sources from the software
installed on your computer. They can also be used to capture settings configured on your computer, such
as Dashboard, Display, and Global Preference settings.

Composer comes with over 100 package manifests. You can use the update feature in Composer to add
new package manifests as they become available. You can also create your own package manifests and
import package manifests that are stored on your computer.

This section explains how to:

= (Create package manifests

= Update the package manifests that are available in Composer
= Import package manifests

Creating Package Manifests

Composer allows you to create custom package manifests from existing package sources and save them
on your computer.

To create a package manifest:

Open Composer and authenticate locally.

Click the disclosure triangle next to an existing package source.
Click the disclosure triangle next to Snapshots.

Control-click (or right-click) Files For Package and select Export Package Manifest.
eoo Composer

w > 2 Q

New Build as DMG  Build as PKG Search

SOURCES [Applications/Firefox.app
v g Firefox [Library/Mozilla
» [ Scripts JUsers/ErinfLibrary/Application Support/Firefox
» (] Sewings.
v []Snapshots

mrt Package Manifest
PACKAGES
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5.

10.

11.

Enter a name for the package manifest.

8 0 0 Export package manifest for Firefox

Package Name: | Firefox

Description: | [required]
|

Created By: I [required]

Files must be present: | fApplications/Firefox.app
[Library/Mozilla
/Users/Erin/Library/Application Support/Firefox

Icon: I‘l || Custom Icon

| Cancel | [ Upload to JAMF Nation | [ Save As.. |

Enter a description of the package manifest and the name of the person who is creating it.

Select the checkbox next to each file that must be present on a computer for the package manifest to
appear under the Pre-Installed Software heading or the User Environment heading in Composer.

If desired, select the Custom Icon checkbox and choose an icon for the package manifest.

The icon is displayed when viewing the package manifest in Composer.

If you want to upload the package manifest to JAMF Nation:
a. Click Upload to JAMF Nation.
b. Enter the username and password for your JAMF Nation account.

JAMF Nation Username: | I

JAMF Nation Password: I I

Third-Party Product: | --- Loading Third-Party Products ---

| Cancel | | Upload

c. Choose a third-party product to associate the package manifest with. For example, if you are creating a
package manifest for Adobe Reader 10, associate it with the "Adobe Reader" third-party product.

d. Click Upload.
Click Save As.

Choose a location to save the package manifest and click Save.
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Updating Package Manifests

Periodically, new package manifests become available for Composer. To ensure that you have the latest
package manifests, choose File > Update Package Manifests from the menu bar in Composer.

Composer downloads the latest package manifests from JAMF Nation and any new package manifests
that JAMF Software has added to the application, and stores them in the following location:

/Library/Application Support/JAMF/Composer/ImportedPackageManifests/

Importing Package Manifests
If you do not want to add all package manifests from JAMF Nation to Composer, you can download one
or more specific package manifests from JAMF Nation and import them to Composer. You can also import

package manifests that you created.

To import package manifests that are saved to your computer, choose File > Import Package Manifests
from the menu bar in Composer. Then, choose the package manifest you want to import.

Composer imports the package manifests and stores them in the following location:

/Library/Application Support/JAMF/Composer/ImportedPackageManifests/
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Editing Package Sources

If a file is listed in the sidebar under the Sources list in the sidebar, it exists as a package source and can
be modified. If a file is not listed in the sidebar under the Sources list, a package source must be created
before you can utilize the editing functions described in this section. See “Creating Package Sources” for
more information about creating a package source.

Note: Composer does not allow you to create a package source from an OS package.

This section explains how to make the following modifications to a package source:
= View and edit the contents of the package source.

= Add scripts.

= Edittheinfo.plistanddescription.plist files.

= Add localizations.

Viewing and Editing the Contents

Once a package source exists for the files you want to package, Composer allows you to:
= Delete files that should not be included in the package

= Add files by dragging them into Composer from the Finder

= Modify permissions on a file or folder

= Restore files that were deleted from the package source

In addition to viewing files or folders through the Composer interface, you can view this information in the
Finder or using Quick Look.

Deleting Files or Folders

In the Package Contents pane, select the item(s) you want to delete from your package source. Then,
choose Edit > Delete from the menu bar.

Adding Files

Drag the file(s) you want to add to your package source from the Finder into the Package Contents pane in
Composer.

Modifying Permissions on Files or Folders

Select a file or folder in the Package Contents pane in Composer to display its permissions in the bottom
of the window. You can change the permissions using this display. Changes are saved automatically. If the
selected item is a folder, you can apply the permissions that exist on the folder to each enclosed item by
clicking the Action button (labeled with the gear icon) to the right of the X-column.
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Restoring Deleted Files or Folders

If you delete a file from the Package Contents pane, it may be possible to restore the file. The ability to
restore a deleted file depends on the type of snapshot used to create the package source and the location
of the file that was deleted. To restore a deleted file, Composer copies the file from its original location on
the drive.

Note: A file can only be restored if a snapshot was used to create the package source.

To restore a deleted file:

Click the disclosure triangle next to the package source in the sidebar.

Click the disclosure triangle next to Snapshots.

Select Files for Package to display a list of files, folders, and directories from the snapshot.
Select the item you want to restore.

Control-click (or right-click) the selected item and choose Restore.

Viewing Files or Folders Using the Finder

In the Package Contents pane, select the item(s) you want to preview. Then, choose File > Reveal in Finder
from the menu bar.

Viewing Files or Folders Using Quick Look

In the Package Contents pane, select the item(s) you want to preview. Then, choose File > Quick Look
from the menu bar or press the Space bar.

Note: Quick Look is supported by OS X v10.5 or later.

Adding Scripts

Composer allows you to manage scripts for PKGs. The following default scripts are available in shell and
perl:

= InstallationCheck
= Postflight

= Postinstall

= Postupgrade

= Preflight

= Preinstall

= Preupgrade

= VolumeCheck
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Note: Flat PKGs support Preinstall and Postinstall scripts only. To build a PKG that contains
other scripts, you can deselect the Build Flat PKGs option in Composer preferences, or you can disable
this preference for a single package. For information on how to disable this preference for a single
package, see “Building PKGs". For more information on flat PKGs, see “Managing Composer Preferences”.

These scripts read in the available parameters that are received from the installer and give descriptions for
the supported exit codes.

Composer also attempts to verify that the script syntax is valid. If a script appears to have invalid syntax, a
warning icon appears.

To view the error that occurred while Composer was verifying the script, Control-click (or right-click) the
script and choose Compile Script.

Note: InstallationCheck and VolumeCheck scripts have warning and failure messages that can
be localized according to the needs of the user. To localize these messages, the corresponding .strings
file (InstallationCheck.strings orVolumeCheck.strings) must be created for each
localization.

To add a script to a package source:
Click the disclosure triangle next to the package source in the sidebar.

Control-click (or right-click) Scripts and choose the script you want to add.

8006 Composer
;) " ‘a

New Build as DMG _Build as PKG. Search

SOURCES
v @ Firefox 7.0

> Scr Add Perl Script > InstallationCheck -
» (i se

: postflight
»[sma  Add Shell Script 4 postinstall

Packaces T [ocinorade Scripts

preflight To add a script to the package, right-click the Scripts folder
preinstall and select the script you wish to add.

preupgrade
VolumeCheck There are default scripts in Perl and Bash for all 8 scripts
e Lhat are supported for a package.

Scripts are only added to PKGs.

The script is displayed under the Scripts heading in the sidebar.

(Optional) Select the script in the sidebar to view or modify its contents.

Adding a Postflight Script that Removes Deleted Files from Clients

Adding a postflight script to a package source allows you to remove deprecated or unneeded files from
client computers as clients install the package.

Note: This function is only available if a snapshot was used to create the package source.
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To add a postflight script that removes deleted files from clients:

Click the disclosure triangle next to the package source in the sidebar.

Click the disclosure triangle next to Snapshots.

Select the Deleted Files heading to view the deleted files captured by the snapshot.

Control-click (or right-click) the Deleted Files heading and choose Add postflight Shell Script.

8086 Composer
|- a
New Build as DMG  Build as PKG Search
SOURCES 1.DocumentRevisions-V100/PerUID/502/2c/com.apple. documentVersions/ CIAIA7 OE-CB28-4633-874D-
¥ @ Firefox 7.0 /.DocumentRevisions-V100/PerUID/502/ 2c/com.apple.documentVersions/ 405 23E0B-705 4-4FD2-8DI5-
» [ Scripts Iprivate/tmp/JAMFLocalAdminTaskStdErrGff1Qp2.err
» [ sertings /.DocumentRevisions-V100/PerUID/502/2d/com.apple.documentVersions/7E1FD903-03BC-401D-B0OC
v (] Snapshots /.DocumentRevisions-V100/PerlID/502/2d

Add postflight Perl Script )0/PerUID/502/30/com.apple.documentVersions/A2C464E6-6DA9-4557-AC7 1
)0/PerlID/502/2¢

PACKAGES T S STl saved Application State/com.apple.Safari. savedState fwindow_208.data

T[T DocumentRevisions V100 /PerUID/502/30/ com.apple.documentVersions
/.DocumentRevisions-V100/PerUID/502/30
1.DocumentRevisions-V100/PerUID/502/2c/com.apple.documentVersions
/.DocumentRevisions-V100/PerUID/502/30/com.apple.documentVersions/8EF26D1E-10C7 -4A8F-9FFA-/
/.DocumentRevisions-VV100/PerUID/502/2d/com.apple.documentVersions
/.DocumentRevisions-V100/PerUID/502/2c/com.apple documentVersions/8A453C66-34D4-4FA9-895E-
/.DocumentRevisions-V100/PerUID/502/2d/com.apple.documentVersions/S4CC7DAA-E053-45E7-8C29

| Files For Pack

The script is displayed under the Scripts heading in the sidebar.

(Optional) Select the script in the sidebar to view or modify its contents.

Editing Info.plist and Description.plist Files

The Installer application uses information property list (info.plist) files and description property list
(description.plist)files to display information about a package and determine how it is installed.
Composer allows you to edit the most commonly used information in these files.

This section explains how to edit these files.



Info.plist File

The info.plist file contains configuration information for a package. Composer allows you to define
theinfo.plist keysand values shown in the screen shot below. After the screen shot, there is a list that
further explains each key and value.

800 Composer
- _*» .9 g
New Build as DMG _Build as PKG i

SOURCES
v '@ Firefox 7.0

» [0 Scripts

v [ Settings Info.plist

w (L] English.Iproj

Description.plist -
5] Bundle Identifier: |org.mozilla.firefox

» [ Snapshots Get Info String: |Firefox 7.0
PACKAGES

Version: |7.0
IF Major Version: |7
IF Minor Version: |0
Restart Action: [ None o

Authorization Action: | Root Authorization o

"] Roat Volume Only

Bundle Identifier
Identifies the package type. For example, com. jamfsoftware. composer

Get Info String
Provides a description of the package. For example, Composer 7.01 © 2009

Version
Identifies the iteration. For example, 7.01

IF Major Version
Identifies the major version number.

IF Minor Version
Identifies the minor version number.

Restart Action
Specifies reboot protocol for a package.

Authorization Action
Specifies authorization requirements.

Root Volume Only
Indicates the package can only be installed to the root volume.

Less commonly used keys and values are also contained in the info.plist file. If you need to edit these

items, Control-click (or right-click) Info.plist in the sidebar and select Edit Manually. This allows you to add
or edit items in raw XML format.
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Description.plist File

Thedescription.plist file allows you to define how a package presents itself in the Installer

application.

Each localization includes its own description.plist file that allows you to define a description title

and description for a package based on the target language.

eo0o Composer

b > Q

New Build as DMG _ Build as PKG Search

SOURCES
v Firefox 7.0
» [ Scripts
w ] Settings.
v (L] English.lproj

Description.plist

Description Title: |Firefox 7.0

| Info.plist
» (] Snapshots. Description:

PACKAGES

There are other keys and values contained in the description.plist file. If you need to edit these
items, Control-click (or right-click) Description.plist in the sidebar and select Edit Manually. This allows

you to add or edit items in raw XML format.

Adding Localizations

Localizations allow you to customize the language used when displaying package information to a user.

By default, a package source only includes an English localization.

Composer includes defaults for the following localizations supported by the PKG format:

= da.lproj =
= Dutch.lproj =
= English.lproj ]
= Fi.lproj ]
= French.lproj =
= German.lproj =
= Ttalian.lproj =
= Japanese.lproj =
= ko.lproj ]

no.lproj
pl.lproj
pt_PT.lproj
pt.lproj
ru.lproj
Spanish.l1lproj
sv.lproj
zh_CN.1lproj
zh_TW.1lproj
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To add a localization to a package source:
Click the disclosure triangle next to the package source in the sidebar.

Control-click (or right-click) Settings and choose the localization that you want to add.

eo0o Composer
2 >
- AL o« 2
New Build as DMG  Build as PKG Search

SOURCES
¥ & Firefox 7.0
» [ Scripts

»C1sn Add Localization for da.lproj
Add Localization for Dutch.Iproj

PACKAGE  Add Localization for fi.lproj Ry SEttlngs
:‘; Package settings allow you to modify the Info.plist file.

Add Localization for German.lproj £

Add Localization for Italian.lproj

Add Localization for Japanese.lproj

Add Localization for ko.lproj

Add Localization for no.lproj

Add Localization for pl.Iproj

Add Localization for pt_PT.lproj These settings are only applied to PKGs.

Add Localization for pt.Iproj

Add Localization for ru.lproj

Add Localization for Spanish.|proj

Add Localization for sv.lproj

Add Localization for zh_CN.Iproj

Add Localization for zh_TW.lproj

i

You can add Description.plist files for different languages by
right-clicking the Settings folder.

By right-clicking a localization folder, you can add the
corresponding strings files for the package.

Adding and Editing Files for a Localization

You can include two types of files in a localization:

= Description.plist files—These files display the title of a package and its description in the Installer
application. Each localization contains adescription.plist file by default. For instructions on
how to edit these files, see “Editing Info.plist and Description.plist Files”.

= Strings files—VolumeCheck.strings and InstallationCheck. strings files are used to
localize warning and error messages. These files are only effective when used in conjunction with their
corresponding scripts (VolumeCheck and InstallationCheck). Forinstructions on how to add
VolumeCheck and InstallationCheck scripts to a package source, see “Adding Scripts”

To add InstallationCheck.strings or VolumeCheck.strings:
Click the disclosure triangle next to the package source in the sidebar.

Click the disclosure triangle next to Settings.
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3. Control-click (or right-click) the language folder you want to add the .strings file to, and select Create
InstallationCheck.strings or Create VolumeCheck.strings.

eoo Composer

SOURCES
v @ Firefox 7.0
» [0 Scripts

tallatiochek.strings

Settings

Package settings allow you to modify the Info.plist file.
PACKAGES

You can add Description.plist files for different languages by
right-clicking the Settings folder.

By right-clicking a localization folder, you can add the
corresponding strings files for the package.

These settings are only applied to PKGs.

4. Click the .strings file to modify its contents in the Package Contents pane.



Building Packages from Package Sources

After you have verified the contents of a package source, Composer allows you to build two different types
of packages: PKGs and DMGs. Each format has advantages depending on the intended use of the package
and the tool you use to deploy it.

Once a package source exists in Composer, you can build a PKG or DMG package from the source at any
time. You also have the ability to convert from one format to another after a package has been built. For
more information about converting between the PKG and DMG formats, see “Creating Package Sources
from Existing Packages”.

This section explains how to build PKGs and DMGs.

Building PKGs

PKGs can be deployed using almost any deployment tool, such as Apple Remote Desktop (ARD), the
Casper Suite, and other client management systems.

The PKG format allows for easy installation by the user. Double-clicking the package opens the Installer
application and guides the user through the installation process.

Note: PKGs cannot dynamically deploy files in the user’s home directory to user templates when used
with the Casper Suite.

By default, Composer builds flat PKGs. For more information on flat PKGs, see “Managing Composer
Preferences”.

To build a PKG:

Select the package source you want to build as a PKG from the Sources list in the sidebar.

Click the Build as PKG button in the toolbar.

Note: If the Build flat PKGs preference is enabled and the package source contains scripts that are not
supported by flat PKGs, a dialog will appear. To disable this preference for this package only, click Build
as non-flat PKG. To build a flat PKG that ignores unsupported scripts, click Build as flat PKG. For more
information on which scripts are supported by flat PKGs, see “Adding Scripts”.

Select a location to save the package and click Save.
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Building DMGs

When used in conjunction with the Casper Suite, the DMG format allows you to dynamically deploy files
and folders to each user that has an account on a computer, as well as the network home directories

of currently logged-in users. There is also an option to deploy files and folders to the user template
directories, ensuring that any new user receives the correct default environment.

To build a DMG:
Select the package source you want to build as a DMG from the Sources list in the sidebar.
Click the Build as DMG button in the toolbar.

Select a location to save the package and click Save.
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Building OS Packages

In addition to building deployable packages of applications and other files, Composer allows you to build

DMGs of pre-configured operating systems. OS packages can save you time and enhance consistency
across your network.

While building an OS package with Composer is similar to building one with the Disk Utility application,
Composer allows you to clean up the OS by removing unnecessary files before building the DMG.

Composer allows you to manage the following cleanup options for an OS package:

Compress Disk Image
This option compresses the OS package DMG.

Delete Temp Files

This option ensures the filesin /private/tmp are deleted before building an OS package. These files are

usually deleted during the startup process.

Delete Virtual Memory Files
This option ensures that Virtual Memory files are deleted before building an OS package, including the
potentially large sleepfile.These files are usually deleted and recreated during the startup process.

Delete Special Files
Apple recommends deleting the following files before building an OS package:

/private/var/db/BootCache.playlist
/private/var/db/volinfo.database

This option ensures that these files are deleted.

Delete Caches
This option removes files in the /Library/Caches directory before building an OS package.

Remove Kerberos Certificate
This option removes existing Kerberos certificates before building an OS package, preventing the “This
computer already exists” error when attempting to bind a computer securely to Open Directory.

Ensure Trashes are Empty
This option empties the Trash for any user with items in the ~/ . Trash folder. It also updates a user’s
com.apple.dock.plist fileto reflect that the Trash is empty.
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Configuring the OS

Before building your OS package, consider performing the following tasks to ensure the OS is completely
configured to your environment:

Install a clean copy of Mac OS X.
Create the main admin account.

For security purposes, create a secondary admin account to be used with Secure Shell (SSH, or remote
login in Mac OS X).

Activate SSH.
Secure SSH by allowing only a single user or group access.
Perform any other system security fortification.
Configure miscellaneous settings, such as:
«  Energy Saver settings
Keyboard and mouse settings
Network settings
QuickTime settings
Sharing settings
+ Login Window settings
« Auto-login settings
«  Name and password or list of users
Run all available software updates.
Turn off the Software Update schedule.
Confirm Universal Access settings.
Confirm Directory Access settings.
LDAPv3 bindings can often be built into your image.
Active Directory bindings should not be built into the image. Each computer must join the domain.

Make sure the Trash is empty.

Packaging the OS

When you're finished configuring the OS, boot to another startup disk to build the DMG.

To build an OS package:

Open Composer and authenticate locally.

Click the New button in the toolbar.

Under the Operating System heading in the sidebar, select Build OS Package.

Select the drive you want to package and click Next.
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5.

6.

Choose options for removing unnecessary files from the package, and then click Next.

Choose options for building your OS package:

™ Compress disk image

™ Delete temp files

™ Delete virtual memory files
™ Delete special files

¥ Delete caches

[ Remove Kerberos certificate
[ Ensure trashes are empty

[ Delete MCX records in the local directory service

Enter a package name and select a location to save the package, and then click Build.
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Managing Composer Preferences

Composer allows you to manage the following settings:
= Toolbar preferences

= Package preferences

= Cleanup options for OS packages

= Excluded files

= Location of the work directory

= Default bundle identifier

You can access Composer preferences by choosing Composer > Preferences from the menu bar.

This section provides a detailed explanation of Composer preferences.

Toolbar Preferences

Composer allows you to customize the toolbar by adding and removing items.

To add items to the toolbar, Control-click (or right-click) the toolbar and select Customize toolbar. Then
drag desired items to the toolbar.

To remove an item from the toolbar, simply drag the item off of the toolbar.

6086 Composer

- . O
e Lot fli ki .
SOURCES
-’ fo Drag your favorite items into the toolbar...
PACKAGES i Z ;.
New Build as PKG Build as DMG Reveal In Finder Quick Look:
9 @ [ ]
Delete Search Space Flexible Space
... or drag the default set into the toolbar.
w A # a
New Build as DMG  Build as PKC Search
Show | Iconand Text 3| [ Use small size
T
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Package Preferences

Composer allows you to manage Package preferences from the pane in the screen shot below.

800 Composer Preferences
Packaging | Exclusion List Advanced
[ Build flat PKGs

O Sign with: com.apple.ubiquity.peer-uuid.3CBD2F3F-4C25-
@] Remove .DS_Store files in common locations
™ Sean images when building DMGs
[9] Play sounds

|_| Reveal in Finder when done

| Cancel | Save

This pane includes the following preference settings:

Build flat PKGs

By default, Composer builds flat PKGs. Flat PKGs consist of a single file and allow for easier and more
reliable deployment than non-flat PKGs. You cannot view or modify the contents of a flat PKG after it is
built.

Sign flat PKGs

This option allows you to sign flat PKGs with an installer certificate (.p12) obtained from Apple’s Developer
Certificate Utility. Signing PKGs with an installer certificate makes it possible to verify that the PKG was
created by an identified developer. It also allows users to install PKGs on computers that have Apple’s
Gatekeeper feature set to only allow applications downloaded from the Mac App Store and identified
developers.

To sign flat PKGs, Composer must be running on OS X v10.7 or later.

Select the Sign with option and choose an installer certificate from the pop-up menu. Installer certificates
that are located in the login keychain in Keychain Access are displayed in the pop-up menu.

Note: The pop-up menu also displays application certificates that are located in the login keychain in
Keychain Access. It is important that you use an installer certificate, not an application certificate, to sign
flat PKGs.

To obtain an installer certificate from Apple’s Developer Certificate Utility, you must be a registered Apple
Developer in the Mac Developer Program. To enroll in the Mac Developer Program, visit the following
website:

https://developer.apple.com/programs/mac/

To install a signed QuickAdd package, the system keychain in Keychain Access must contain Apple’s
Developer ID Certification Authority intermediate certificate. For instructions on how to obtain this
certificate and import it to the system keychain on client computers, see the following Knowledge Base
article:

https://jamfnation.jamfsoftware.com/article.html?id=294
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Remove .DS_Store Files in Common Locations

Enabling this option ensures the removal of any files that disturb the way Finder windows are presented
on a user’s computer. Any .DS_Store files necessary to configure views of deployed files and folders will not
be removed.

This feature removes .DS_Store files in the following locations:
/.DS_Store

/Applications/.DS_Store
/Applications/Utilities/.DS_Store
/Developer/.DS_Store

/Library/.DS_Store

/System/.DS_Store

/Users/.DS_Store

/Users/<username>/.DS_Store
/Users/<username>/<first_level_directory>/.DS_Store

Scan Images When Building DMGs
Scanning images when building a DMG calculates the checksum and stores it in the DMG.

The checksum is used to ensure proper installation of the DMG package.

Play Sounds
Composer plays a sound each time a package source is created or deleted.

Reveal in Finder when done
When this option is enabled, Composer reveals newly built packages in a Finder window.

Exclusion List

The exclusion list allows you to specify files and folders that should be ignored when creating a package
using a snapshot or file system monitoring.

To view the exclusion list, click the Exclusion List button in the toolbar. A list of common files and folders is
specified by default.
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To add and remove files, use the Add (+) and Delete (-) buttons at the bottom of the list.

[-NsNs] Composer Preferences

Packaging Lxclusmﬂ List Advan(ed

Composer will ignore the following files while creating a new package:

.com.apple.timemachine.supported

.DS_Store

fseventsd

.Trash

f.volf

Jautomount/

Jdevf

/Library/Application Support/Adobe/Adobe PCD/
/Library/Application Suppart/JAMF/
/Library/Caches/

/Library/lcons

[Library/Mail/
/Library/Preferences/SystemConfiguration/preferences.plist
J/mach.sym

/Network/

/private/etc/authorization
/private/etc/cups/printers.conf

[private/tmp/
Reset

Advanced Preferences

Composer allows you to manage some advanced preferences from the pane in the screen shot below.

8o0e Composer Preferences
Packaging Exclusion List Mvamed{

Work directory for package building
[Library/Application Support/JAMF/Composer/Sources | Change...

| Reset |

Default bundle identifier: |com Jjamfsoftware

Reset all dialog warnings: | Reset Warnings |

Gl

This pane includes the following preference settings:

Work Directory
When Composer creates a package source, it copies files to a work directory. This work directory must have

permissions enabled.

To change this directory, click the Change button, or hold down the Option key when you open
Composer.

Default Bundle Identifier

The default bundle identifier is used when creating the info.plist file for a new package source. For
example, if the default bundle identifier is“com. jamfsoftware’, and you create a package source
named “Composer”, the bundle identifier for the package source is“com. jamfsoftware. composer”
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Building Your Client
Management Framework

Integrating with LDAP Servers

If you utilize one or more directory services to store information about the users in your organization, you
can integrate the JAMF Software Server (JSS) with the directory service(s) to:

= ook up and populate user information for inventory purposes
= Authenticate users to the Casper Suite
= Authenticate users to Self Service

= Assign policies and Managed Preference profiles to user groups

Note: Integrating with Open Directory allows the JSS to access both user and computer list information.
For details on accessing computer list information from Open Directory, see the “Adding LDAP Server
Connections Manually” section.

This section explains how to:

= Add LDAP server connections using the LDAP Server Connection Assistant or manually
= Test LDAP server connections

= Edit and delete LDAP server connections

= Troubleshoot LDAP server connections

Using the LDAP Server Connection Assistant

The LDAP Server Connection Assistant walks you through the process of adding an LDAP server
connection to the JSS.

The assistant allows you to integrate with the following directory services:
= Apple’s Open Directory
= Microsoft’s Active Directory

= Novell’s eDirectory

Note: To integrate with other directory services or access computer list information from Open Directory,
you must configure the connection manually.
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To use the LDAP Server Connection Assistant:
1. Login to the JSS with a web browser.
2. Click the Settings tab.
3. Click the LDAP Server Connection link.
4. Click the Add LDAP Server Connection button.
5. Choose the LDAP server you want to integrate with and click the Continue button.
6. Enter the host name (DNS name or IP address) for the LDAP server and click Continue.
7. Enter credentials for the LDAP service account and click Continue.

8. For testing purposes, enter the usernames for two different accounts in the LDAP server and click
Continue.

9. Verify the returned attribute mappings are correct. If the attribute mappings are correct, click Continue
and skip to step 11.

LDAP Server Connection Assistant

Mappings
@

Verify Attribute Mappings

Verify that the attributes from your LDAP server are mapped correctly to the JS5.
To change an attribute mapping, click the ellipsis button across from it.

IS5 User Attribute LDAP User Attribute Value for bcrocker_OD Value for dsmith_0D
Username: uid bcrocker_0OD dsmith_OD
Realname: «¢n Betty Crocker Dave Smith
Email: | mail berocker@jamfsoftware.com  dsmith@jamfsoftware.com

Phone:

Department:
Building:
Room:
Position:

10. If an attribute mapping is incorrect, change the mapping appropriately.
a. Click the Ellipsis button across from the mapping.
b. Choose the correct value for the attribute from one of the pop-up menus.

LDAP Server Connection Assistant

Mappings
@

Edit Mappings for Email

Choose the value for the attribute from one of the pop-up menus, and then click the Return to Verify Mappings button.

Value for berocker_OD: | berocker@jamfsoftware.com [}
Value for dsmith_OD: [ dsmith@j e.com [

Return to Verify Mappings

c. Click the Return to Attribute Mappings button.
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11.

12.

13.

d. Verify the changes are correct and click the Continue button.
For testing purposes, enter the names of two different user groups in the LDAP server and click Continue.

Verify the group membership status of each test user is correct and click Continue.

LDAP Server Connection

Mappings

@
Verify Group Results
Verify that the membership status for each user is correct.
If the results are incorrect, use the Edit Manually button on the next pane to verify group membership mappings.
Group Name  bcrocker OD's Membership Status | dsmith_OD's Membership Status
Staff Not a member Not a member
Admin Not a member Not a member

Click Save to save the LDAP server connection and continue using the JSS.

If you want to make changes before you save the connection, click the Edit Manually button, make the
necessary changes, and then click the Save button.

Adding LDAP Server Connections Manually

Before adding an LDAP server connection manually, it is important that you are familiar with search bases,
object classes, and attributes. If you are not familiar with these concepts, use the LDAP Server Connection
Assistant to ensure attributes are mapped correctly.

Adding the connection manually allows you to:
= Integrate with directory services other than Open Directory, Active Directory, and Novell eDirectory

= Access computer list information from Open Directory

After adding the connection, test it to make sure it’s working properly. See the “Testing LDAP Server
Connections” section for testing instructions.

This section provides an overview of the Connection and Mappings panes you'll use to add the connection
and step-by-step instructions on how to do so.
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Connection Pane

This pane allows you to configure how the JSS connects to an LDAP server.

Edit LDAP Server Connection

Connection Mappings
Display Name:

Host name:
] Encrypt using SSL
[Tl Use custom port 389

Use for: | Users and User Groups FG']

Create Mappings Based On: [Open Directory (05 X Server) i-‘-l

Domain:

Authentication Type: | None B‘

Open/Close times out in: | 15 seconds

Connection times out in; 60 seconds

Referrals: | Default from provider B‘

# Use wildcards when searching for objects

Display name
This field allows you to enter a display name for the LDAP server.

Host name
This field allows you to enter the DNS name or IP address for the LDAP server.

Encrypt Using SSL
You must select this checkbox if you want to connect to the LDAP server over SSL.

Note: For this to work, the LDAP server must have SSL enabled.

Use custom port
If the LDAP server is not running on the standard port, you must select this checkbox and enter the port
on which it is running.

Use for
This pop-up menu allows you to specify the type of information you want to access from the LDAP server.

Create Mappings Based On
This pop-up menu allows you to select the LDAP server you want to connect to.

Domain
This field allows you to enter the domain for the LDAP server.
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Authentication Type

If the LDAP server requires authentication, specify the authentication type using this pop-up menu. After
choosing an authentication type, two additional fields appear in which you can enter credentials for the
LDAP service account.

Most LDAP servers require simple authentication.

Open/Close times out in seconds
This field allows you to enter the maximum number of seconds you want to wait for the server to open or
close a connection before it times out.

Connection times out in seconds
This field allows you to enter the maximum number of seconds you want to wait for the server to return
results before the connection times out.

Referrals
This pop-up menu allows you to choose whether to ignore, follow, or utilize default LDAP referrals to
locate information.

Use wildcards when searching for objects

Select this checkbox if you want the JSS to return partial matches when searching the LDAP server for
information.

Mappings Pane

This pane allows you to map attributes and specify object class and search base data.

If you're not familiar with these concepts, use the LDAP Server Connection Assistant to add the
connection.

Edit LDAP Server Connection
Connection Mappings
Users
Map Users to | Al B‘ ObjectClass values below
ObjectClass: (Comma separated)

Search Base:

@ all subtrees () first level only

Map User ID to:

Map Username to:

Map Real Name to:

Map Email Address to:
Append to email results:
Map Department to:
Map Building to:

Map Room to:

Map Phone to:

Map Position to:

Map User UUID to:
# Bindable String Repr i ded
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6.

7.

To configure an LDAP server connection manually:
Log in to the JSS with a web browser.

Click the Settings tab.

Click the LDAP Server Connection link.

Click the Add LDAP Server Connection button.

Select the Configure manually option and click the Continue button.

Configure the connection using the information on the Connection and Mappings panes.

Click the Save button.

Testing LDAP Server Connections

Before using an LDAP server connection as part of your framework, test the connection by looking up user

(or computer list) information. If the results are returned correctly, the connection is working.

This section explains how to look up user and computer list information.

To look up user information from an LDAP server:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the LDAP Server Connection link.

Click the Test link across from the connection you want to test.

LDAP Server Connections

L]
Add LDAP Server Connection
LDAP Display Name Hostname Used For
@ 0D Connection od.jamfsw.corp  Users and Croups | Edit Test Delete

Click the User Lookup, User Group Lookup, or User Group Membership Lookup tab.

Enter information in the field(s) provided.

Test LDAP Server Connection: OD Connection

5 8 n n

User Lookup User Group Lookup User Group Membership Lookup

Click the Test button.
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To look up computer list information from Open Directory:
Log in to the JSS with a web browser.

Click the Settings tab.

Click the LDAP Servers Connection link.

Click the Test link across from the Open Directory connection you want to test.

LT
Add LDAP Server Connection

LDAP Display Name Hostname Used For
© 0D Connection od.jamfsw.corp =~ Users and Groups  Edit Test Delete

Click the Computer Lookup, Computer Group Lookup, or Computer Group Membership Lookup tab.

Enter information in the field(s) provided.

Click the Test button.

Editing LDAP Server Connections

To edit an LDAP server connection:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the LDAP Servers Connection link.

Click the Edit link across from the connection you want to edit and make changes manually.

For more information about the Connection and Mappings panes, see the “Adding LDAP Server
Connections Manually” section.

Click the Save button.

Deleting LDAP Server Connections

To delete an LDAP server connection from the JSS:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the LDAP Servers Connection link.

Click the Delete link across from the connection you want to delete.

Click the Delete button to confirm.
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Tools for Troubleshooting LDAP Server Connections

This section describes two tools you can use to troubleshoot the connection between the JSS and an LDAP
server.

Apache Directory LDAP Studio

The Apache Directory LDAP Studio allows you to connect to an LDAP server to pinpoint initial connections
and find search bases and mappings. You can download Apache Directory LDAP Studio at:

https://directory.apache.org/studio/

Workgroup Manager

Apple’s Workgroup Manager allows you to view detailed information for individual LDAP server accounts.

To view LDAP information using Workgroup Manager:

Open Workgroup Manager.

Connect to your server.

From the menu bar, choose Workgroup Manager > Preferences.

Select the Show “All Records” tab and inspector checkbox, and then click OK.

Click the All Records tab (target icon) displayed in the sidebar to view the records.
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Managing JSS User Accounts

The JAMF Software Server (JSS) is a multi-user application. You can grant different levels of access to each
user by setting up JSS user accounts and assigning different privileges to each one.

Individual JSS user accounts can be created manually or—if you have an LDAP server connection set up—
added from a directory service. You can also grant access to groups from an LDAP server.

This section explains how to:

= Create a new user account in the JSS

= Add a user account from an LDAP server

= Upgrade the Distinguished Name (DN) from an LDAP account

= Grant access to a group from an LDAP server

Note: JSS users added from an LDAP server receive the privileges assigned to their individual user
accounts. LDAP members that don’t have individual accounts in the JSS, but are members of one or more
groups with access, receive the privileges assigned to each group.

Important: It is recommended that you have at least one JSS user account that is not from an LDAP
server in case the connection between the JSS and the LDAP server is interrupted.

To create a new user account in the JSS:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Accounts link.

Click the Create New Account button.

Accounts and Groups

X 5 5 2

Create New Account Add Account from LDAP Add Group from LDAP

Accounts
Username  Real Name Email Address Phone Number
@ | admin Admin User | admin@mycompany.com Edit Account
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Enter user information on the Account pane.

Create New Account

b 8 [ & s

Account Privileges API Privileges Notifications

Username: ,jSSUser—|
Realname: ,—|
Email Address: ,—|
Phone: |—|

Password: ssssssss

Click the Privileges tab and select the checkbox next to each privilege you want to grant the user.

Create New Account

B § - & L

Account Privileges AP Privileges Notifications

Grant All Privilages
Revoke All Privileges

J55 = Home Tab Privileges
™ Change Password
J55 = Inventory Tab Privileges

View Inventory Tab
Perform Advanced Searches
Save Advanced Searches

®E®

Click the API Privileges tab and select the API privileges you want to grant the user.

Create New Account

§ & a & s

Account Privileges API Privileges Notifications

Read Update Create
Buildings ™
Categories ™
Computers a =] [
Computer Groups =
Departments B8

Delete
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8. Click the Notifications tab and select the checkbox next to each event you want the user to receive a
notification about.

Note: A valid email address must be entered on the Account pane for notifications to be sent.

Create New Account

'} a & s

Account Privileges AP Privileges Notifications

Set All Notification Events
Revoke All Notification Events

Imaging Notifications

# Computer Added from PreStage
# Imaging/Autorun Error

9. Click Save.

To add a user account from an LDAP server:
1. Login to the JSS with a web browser.
2. Click the Settings tab.
3. (Click the Accounts link.

4. Click the Add Account from LDAP button.

If you don't see this button, you need to set up an LDAP server connection before completing these steps.
(For more information, see the “Integrating with LDAP Servers” section.)

Accounts and Groups

X

Create New Account Add Account from LDAP Add Group from LDAP

Accounts
Username  Real Name Email Address Phone Number
© | admin Admin User = admin@mycompany.com Edit Account | (Logged In

5. Enter the username for the account you want to add and click Next.

Add User From LDAP Server

Add User with username: | Berocker 0D

6. When the JSS returns the results, click the Add <username> link next to the user you want to add.

ue 1D Us Distinguished Name Real Name Email
1038 berocker OD | uid=bcrocker_OD,cn=users,dc=0d dc=jamfsw,dc=corp | Betty Crocker | berocker@jamfsoftware.com | Add berocker_OD...
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Configure accounts settings on the Privileges, API Privileges, and Notifications panes.

Click Save.

To update the Distinguished Name (DN) for an LDAP account:
Log in to the JSS with a web browser.

Click the Settings tab.

Click the Accounts link.

Click the Edit Account link next to the account you want to modify.

Click the Update DN button.

Create New Account

B 8 (o) & L

Account Privileges AP Privileges Notifications

Username: bhcrocker_0D

Realname: Betty Crocker
Email Address: m
phone:

Distinguished Name: uid=bcrocker OD,cn=user

Update DN...

(This user is from an LDAP Server)

Enter the new Distinguished Name and click Save.

Create New Account

B § a & &

Account Privileges AP Privileges Notifications

New Distinguished Name

uid=bcrocker_OD,cn=users,dc=od,dc=jamfsw,dc=corp

To grant access to an LDAP group:

Log in to the JSS with a web browser.
Click the Settings tab.

Click the Accounts link.
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Click the Add Group from LDAP button in the toolbar.

If you don't see this button, you need to set up an LDAP server connection before completing these steps.
(For more information, see the “Integrating with LDAP Servers” section.)

Accounts and Groups

> 3 > .

Create New Account Add Account from LDAP Add Group from LDAP

Accounts
Username  Real Name Email Address Phone Number
@ | admin Admin User | admin@mycompany.com Edit Account | [Logged |0

Enter the name of the group you want to add and click Next.

Add User From LDAP Server

When the JSS returns the results, click the Add <group name> link next to the group you want to add.

Group 1D Group Name

20 staff Add staff...

1025 alljamfstaff | Add alljamfstaff...
1038 financestaff | Add financestaff...

1039 culinarystaff = Add culinarystaff...

Set privileges for the group on the Privileges pane and click Save.
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Adding Software Update Servers

Apple allows you to host your own software update server internally using Mac OS X Server. This reduces
bandwidth by downloading the packages once per server instead of once per client and allows you to
approve updates before they become available.

Before using Casper Remote or a policy to run Software Update from an internally hosted software update
server, you need to specify one or more servers in the JAMF Software Server (JSS).

When Casper Remote runs Software Update on remote computers, the process takes place in the
background, so users don'’t see the process and are not prompted to authenticate. This also means the
user does not need to be an administrator or even be logged in for Software Update to run on the client.

Running Software Update with Casper Remote or a policy installs all available software updates for the
computer. You can control which updates are available using the Server Admin application on Mac OS X
Server.

This section explains how to add, edit, and delete a software update server.

To add a software update server:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Servers link.

Click the Add Server button in the toolbar.

Select the Software Update option and click Continue.
Enter a display name for the server.

Enter the DNS name or IP address for the Mac OS X Server on which the Software Update service is
running.

If you are not using port 8088, enter the port you are using in the Port field.

If you do not want to use this server as the default software update server for all users, deselect the Set
Server System Wide checkbox.
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10.

Click the Save button.

Edit Software Update Server: Untitled Software Update Server

Display Name: Software Update Serve

Port: 8088
Set Server System Wide: &

To edit a software update server:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Servers link.

Click the Software Update Servers tab.

Click the Edit Server link next to the server and make the necessary changes.

Click the Save button.

To delete a software update server:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Servers link.

Click the Software Update Servers tab.

Click the Delete Server link next to the server.

Click the Delete button to confirm.
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Adding NetBoot Servers

If you have one or more NetBoot servers configured in the JAMF Software Server (JSS), you can reboot
clients to a NetBoot server remotely using a policy or Casper Remote.

NetBoot servers are not set up automatically. To set up a NetBoot server, you need to set up Mac OS X
Server, configure the NetBoot service, and then create the NetBoot image.

There are a few different ways you can set up a NetBoot server when you add it to the JSS—each gives you
a different level of control. You can set up a NetBoot server that allows you to:

= Boot to a default image
= Boot to a non-default image

= Boot using manually entered information

This section explains how to set up, edit, and delete a NetBoot server in the JSS.

To boot a NetBoot server to a default image:
Log in to the JSS with a web browser.

Click the Settings tab.

Click the Servers link.

Click the Add Server button in the toolbar.
Select the NetBoot option and click Continue.
Enter a display name for the server.

Enter the IP address for the NetBoot server.

Display Name: NetBoot Server

IP Address: 192.168.1.100

Use Default Image: &

Click the Save button.

To boot a NetBoot server to a non-default image:
Log in to the JSS with a web browser.

Click the Settings tab.

Click the Servers link.

Click the Add Server button in the toolbar.
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10.

11.

12.

13.

14.

Select the NetBoot option and click Continue.

Enter a display name for the server.

Enter the IP address for the NetBoot server.

Select the Use Specific Image option.

Use the Target Platform pop-up menu to specify the processor architecture for the NetBoot image.

In the Share Point field, enter the share point for the image. This is usually something like NetBootSP@.
You can locate the directory name in the folder on Mac OS X Server in the following location:
/Library/NetBoot/

In the Set field, enter the set in the directory you specified in the Share Point field.

This usually starts with Image_ followed by the index of the NetBoot image, and the .nbi file extension.
For example, image_10012049807 . nb1i.

In the Image field, enter the NetBoot image in the directory you specified in the Share Point field.

This is usually identified as System. dmg.

Choose “NFS" or “HTTP” from the Protocol pop-up menu.

Edit NetBoot Server: NetBoot Server

Display Name: NetBoot Server

IP Address: 192.168.1.100

Use Default Image: ()

Use Specific Image: &

Target Platform: | Intel/x86 B‘

Share Point: |NetBoatSPO

Set: |image_10012049801.nbi

image:

Protocol: | NFS %

Configure Manually: )

boot-args:

boot -file:

boot-device: enet:192.168.1.100

@D @)

Click the Save button.

To boot a NetBoot server using manually entered information:
Log in to the JSS with a web browser.

Click the Settings tab.

Click the Servers link.

Click the Add Server button in the toolbar.
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Select the NetBoot option and click Continue.
Enter a display name for the server.

Enter the IP address for the NetBoot server.
Select the Configure Manually option.

In the fields provided, enter the boot -args, boot-file, and boot-device that should be set in Open
Firmware/EFI and click the Save button.

Note: These items must be entered exactly. The arguments for NetBoot images used with PowerPC-based
hardware should look similar to this:

Boot -args
rp=nfs:192.168.1.9:/private/tftpboot/NetBoot/NetBootSPQ:Image_10012040959.
nbi/System.dmg

Boot-file
enet:192.168.1.9,NetBoot\NetBootSPO\Image_10012040959.nbi\mach.macosx
Boot-device

enet:192.168.1.9,NetBoot\NetBootSPO\Image_10012040959.nbi\booter

The arguments for NetBoot images used with Intel-based hardware should look similar to:

Boot -args
rp=nfs:192.168.1.9:/private/tftpboot/NetBoot/NetBootSP0:image_10012040959.
nbi/System.dmg

Boot-file
tftp://192.168.1.9/NetBoot/NetBootSP0/image_10012040959.nbi/1i386/mach.
macosx

Boot-device
tftp://192.168.1.9/NetBoot/NetBootSP0/image_10012040959.nbi/1i386/booter

Edit NetBoot Server: NetBoot Server

Display Name: NetBoot Server

IP Address: 192.168.1.100

Use Default Image: ()

Use Specific Image: ()

Target Platform: | PowerPC B‘

Share Point:
Set:
Image:

Protocol: | NF5 %

Configure Manually: &

boot-args: rp=nfs:192.168.1.9:/private tftpboot/NetBoot/NetBootSPD:Image_L00120408

boot-file: |ener:192.168.1.9,NetBoot|NetBootSP0|Image_10012040959.nbilmach,Magos

boot -device: lenet 192.168.1.9 NetBoot|NetBootSP0 | Image_10012040959.nbibooter l
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To edit a NetBoot server:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Servers link.

Click the NetBoot Servers tab.

Click the Edit Server link next to the server and make the necessary changes.

Click the Save button.

To delete a NetBoot server:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Servers link.

Click the NetBoot Servers tab.

Click the Delete Server link across from the server.

Click the Delete button to confirm.
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Managing Buildings and Departments

Buildings and departments are organizational components that give you an easy way to perform
inventory searches, assign policies to client computers, and assign Managed Preferences to client
computers.

Buildings

This section explains how to create, edit, and delete a building in the JAMF Software Server (JSS).

To create a building:

Log in to the JSS with a web browser.
Click the Settings tab.

Click the Buildings link.

Click the Create New Building button.

Enter a name for the building and click the Save button.

Building Name: | JAMF EC

Cancel ) ( Save

To edit a building:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Buildings link.

Click the Edit Building link across from the building that you want to edit.
Change the name of the building.

Click Save.

To delete a building:

Log in to the JSS with a web browser.
Click the Settings tab.

Click the Buildings link.

Click the Delete Building link across from the building that you want to delete.



Click Delete to confirm.

Departments

This section explains how to create, edit, and delete a department in the JSS.

To create a department:

Log in to the JSS with a web browser.
Click the Settings tab.

Click the Departments link.

Click the Create New Department button.

Enter a name for the department and click the Save button.

Edit Department

Department ame:

@ G

To edit a department:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Departments link.

Click the Edit Department link across from the department that you want to edit.
Change the name of the department.

Click Save.

To delete a department:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Departments link.

Click the Delete Department link across from the department that you want to delete.

Click Delete to confirm.
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Managing Network Segments

A network segment is a range of IP addresses that can be used to perform the following actions:

= Assign client computers to the closest distribution point.

= Update the department and/or building to which client computers belong.

= Limit a policy’s scope to ensure that the policy does not run when client computers are offsite.

= Limit a PreStage’s scope to image only client computers within the specified IP range.
Network segments can be class B or class C subnets, or any IP range therein.

This section explains how to create, edit, and delete a network segment in the JAMF Software Server (JSS).

To create a network segment:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Network Segments link.

Click the Create New Network Segment button in the toolbar.

Enter a display name for the network segment.

Specify an IP range for the network segment by entering starting and ending IP addresses.

If you want to assign a distribution point, NetBoot server, or Software Update server to the network
segment, make your selections from the corresponding pop-up menus.

Display Name:  Network Segment
Starting IP Address: 10.10.12.1

Ending IP Address: | 10.10.14.255

Default Distribution Point: | No Distribution Point -¢]

Default NetBoot Server: | No NetBoot Server | &
Default Software Update Server: | No Software Update Server | & ]
Default Department: | No Department [&]

© [ Override Departments in Inventory

Default Building: | No Building | % ]

© [ Override Buildings in Inventory

(cancel ) (save )

If the IP range falls within a specific department and/or building, use the Default Department and
Building pop-up menus to specify which one(s) it belongs to.

If you want clients within the network segment to reflect this department and/or building in their
inventory record when they enter the segment, select the Override Departments/Buildings in Inventory
option(s).
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10.

Click the Save button.

To edit a network segment:

Log in to the JSS with a web browser.
Click the Settings tab.

Click the Network Segments link.

Click the Edit Network Segment link across from the network segment that you want to edit and make the
necessary changes.

Click Save.

To delete a network segment:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Network Segments link.

Click the Delete Network Segment link across from the network setting you want to delete.

Click Delete to confirm.
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Managing Packages

This section explains how to:

Add new packages

Change package attributes

Add DMGs of Adobe Installer DVDs
Add DMGs of Adobe Updaters

Add DMGs of Mac OS X Installer DVDs
Index packages

Delete packages

Adding New Packages

Before you deploy a package, you must add it to the JAMF Software Server (JSS) using Casper Admin and
assign it to one or more distribution points.

There are two ways to add a new package to Casper Admin:

Dragging Packages into Casper Admin

Drag a package into Casper Admin

Copy the package directly to a distribution point

When you drag a package into Casper Admin, it is copied to the master distribution point and displayed in

blue text in the Unknown category until you assign it to a software category.

To add a package to Casper Admin:

Open Casper Admin and authenticate to the JSS.

Drag the package from the Finder to the Package pane in Casper Admin.

Copying Packages Directly to the Distribution Point

This method copies the package to the Packages folder at the root of the file share. You can enter
information about the package into the JSS manually.

If you open Casper Admin after adding the package, the name of the package is displayed in blue text in
the Unknown category in the sidebar.

To add a package manually:

Copy the package to the Packages folder on your distribution point.

Log in to the JSS with a web browser.
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Click the Settings tab.
Click the Casper Admin link.

Click the New Package button and enter information about the package on the Info pane.

Note: The information entered in File Name field must match the name of the file exactly.

Click Save.

Edit Package:

0 < L

Info Options Self Healing

Package Info

Display Name: Firefax.dmg Category:

File Name: |Fircfox.dmg I

Note: If you change the file name here, you will need
to do so manually on your Distribution Point(s)

Info:

Notes:

Changing Package Attributes
You can change the attributes that determine how a package is installed.

This section explains:
= How to modify package attributes using Casper Admin or the JSS

= The attributes listed on the Summary, Info, and Options panes

To change package attributes using Casper Admin:
Open Casper Admin.

Select the package that you want to change.

Click the Info button in the toolbar.

Make changes to the information on the Info and Options panes, and then click OK.
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To change package attributes using the JSS:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Casper Admin link and click the package name.

Make changes on the Info and Options panes, and then click Save.

Summary Pane

This pane displays an overview of the package. The Reveal in Finder button displays the package in a
Finder window.

Note: The Summary pane exists in the Casper Admin application only. It is not included in the web
version of Casper Admin.

. ’ ) rmation for Firefo
(-Summary- Info  Options |
Display Name: Firefox 3.6.dmg
File Name: Firefox 3.6.dmg
Category: Software Reveal in Finder
Kind: JAMF Package Format: DMG Package
Size: nja Priority: 10
Date Created: 2/18/11 at 3:28 PM User Templates: No
Date Modified: 2/18/11 at 3-28 PM Existing Users: No
1S5 1D: 106 Reboot Required: n/a
Executable: n/a Stage: Deployable

Computers that have a package receipt for this: nja
Configurations that this is a member of: 0
Computers that use this for autorunning: n/a

(o) (o) O
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Info Pane
This pane allows you to modify basic information about a package.

OO Information for Firefox 3.6.dmg

" Summary | Info. Options |

Display Name Category
| Firefox 3.6.dmg | [ software ]

File Name
Firefox 3.6.dmg

D This file is a disk image containing an installer (Mac OS X or an Adobe Installer/ Updater)
Info

Notes

(‘Previous ) [ Next ) (" cancel )
St S Wil |

The following attributes are displayed on this pane:

Display Name
This is the customizable name that identifies a package when it is displayed in a list of packages or policies.
The display name does not have to match the name of the package.

File Name
This is the name of the package.

If you change a filename using the web version of Casper Admin, you must manually update the filename
on each distribution point. If you change a filename using the Casper Admin application, this information
is automatically updated for you.

Category
This identifies the organizational category to which a package belongs.

Info
The information displayed to the administrator when a package is being deployed.

Notes

Notes are only displayed in Casper Admin. They are helpful when tracking information about a package,
such as who created it and when it was built.
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Options Pane

This pane allows you to specify deployment information and set criteria that limits whether a client
computer can install or uninstall a package.

Setting these limitations prevents packages from being deployed to client computers that should not
receive them.

OB Information for Firefox 3.6.dmg

(“Summary  Info |-Options-

Package Options
Priority: | 10 5 | Fill User Templates

|_ Requires Reboot __ Fill Existing User Home Directories

|| This package must be installed to the boot volume at imaging time

Package Limitations

Stage: | Deployable @

Allow this package to be uninstalled by Casper or a Policy

0OS Requirements:

Enter possible matches (such as 10.4 or 10.4.1) separated by commas. If you
would like to include all versions of 10.4, enter "10.4.x".

[ Install Only if Processor is: | PowerPC
If the target computer is not PowerPC Do not install

Install only if SWU reports the package as available

(Previous )  Next )
Previous Next ) (Cancel ) @

The following attributes are displayed on this pane:

Priority

This determines the order in which packages are installed. For example, an OS package should have a
priority of 1 to ensure that it is installed first. An updater or a package that needs to overwrite files that
may exist in another package should have a priority of 20.

Fill User Templates

The default settings for a new user’s home directory are located in the User Template folder. When you
select this option, the files and folders in the first home directory located in /Users/ are copied to the
User Template directories in:

/System/Library/User Template/

Selecting this option allows you to distribute preferences or documents and provide a default work
environment to any new user on a client computer.

Note: This option is only available for DMG packages.
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Fill Existing User Home Directories
Selecting this option copies the files and folders in the first home directory located in /Users/ to every
existing home directory on the client computer.

Note: This option is only available for DMG packages.

This package must be installed to the boot volume at imaging time
If this option is selected, Casper Imaging installs the package with the first run script.

Stage

You can limit how a package is used and deployed by choosing one of the following options from the

Stage pop-up menu:

= Testing—The package can only be deployed using Casper Remote (not a policy), and can only be
pushed to five computers at a time.

= Non-Deployable—The package cannot be deployed. This setting is useful if the package needs to be
taken out of production temporarily for licensing or other reasons.

= Deleted—The package has been deleted from Casper Admin.

Allow Uninstall

Selecting this option allows administrators to uninstall a package using a policy or Casper Remote.
Administrators will not be able to uninstall a package using a policy or Casper Remote unless this option is
selected.

Some packages—for example, operating system updates and security updates—should not be
uninstalled, since they contain files required to boot the client computer.

Note: A package must be indexed before this option can be selected. (For more information on indexing
packages, see the “Indexing Packages” section.)

OS Requirements
If certain operating system requirements are needed to install a package, enter the requirements in this
field using the following guidelines:

= |fa package can be installed on any version of OS X v10.6 (but not v10.5), type “10.6.x".
= |fa package can only be installed on OS X v10.5.6, type “10.5.6".
= |f the entry has more than one requirement, separate each requirement with a comma.

= |f a package does not have any operating system requirements, leave this field blank.
Install Only if Processor Is [PowerPC/x86]

Some packages are built only for a single architecture. You can specify this information by selecting this
option and choosing PowerPC or X86 from the pop-up menu.

To install an alternate package when a non-compliant architecture is encountered, choose an alternate
package from the If the target computer’s processor is not there pop-up menu.
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Install Only if SWU Reports are Available
Selecting this option prompts Casper Remote or a policy to run Software Update for packages that may be
available as updates.

For this feature to work properly, you must remove the .pkg or .mpkg file extension from the package’s
display name. If this still does not work, execute the following command in a Terminal window:

softwareupdate -1

Itis important to ensure the information provided in the Display Name field matches the name of the
package that is displayed in the command-line version of Software Update.

Note: This option is only available for PKG packages.

Adding DMGs of Adobe Installer DVDs

Adobe CS3 and CS4 products can be deployed without repackaging by adding a DMG of the Adobe
Installer DVD to Casper Admin and identifying it as an Adobe Installer Image.

If you download installer media directly from Adobe, it is already in DMG format. If you have installer
media on DVD, you must first create the DMG using Disk Utility.

Since the Adobe Installer Image, itself, is not a deployable object, you must use Casper Admin or the JSS to
create the Adobe installations that install and configure Adobe products.

Creating an Adobe installation involves the following steps:
Create the DMG.
Add the Adobe Installer DMG.

Create a new Adobe installation using Casper Admin or the JSS.

Step 1: Create the DMG

Insert the installer DVD into a computer with Mac OS X.

Open Disk Utility from the Utilities folder.

Click the DVD button in the sidebar.

From the menu bar, choose File > New > New Image From <name of the DVD>.

Save as a compressed DMG.

Step 2: Add the Adobe Installer DMG
Open Casper Admin.

Drag the DMG of the Adobe Installer DVD into Casper Admin.
This copies the DMG directly to the master distribution point.

After Casper Admin copies the DMG, the Info pane is displayed. If it does not appear, click the Info button

in the toolbar.
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Click the Info tab and select the This file is a disk image containing an installer (Mac OS X or an Adobe
Installer/Updater) option.

It can take Casper Admin up to 30 seconds to analyze the contents of the DMG. When this process is
complete, the Options pane appears and a list of payloads available with the installer is displayed.

DS

Summary . Infe Options |

Display Nome Category
|[rs4 web Standard.dmg | (Adobe Installers 2]
File Name

54 Web Standard.dmg

E'I'his file is a disk image containing an installer (Mac 05 X or an Adobe Installer/Updater)

Info

Notes

Click OK and select Adobe Installer Images in the View Type list to see the listing for the DMG.

Step 3: Create a New Adobe Installation Using Casper Admin
Open Casper Admin.
Click the New Adobe Install button in the toolbar.

If you have multiple Adobe Installer Images, choose the one on which you want to base your installation
from the Installer Image pop-up menu.

Please choose the Adobe Installer Image that you wish to create
the installation from.

Installer Image: | CS4 Web Standard.dmg ]

( Cancel ) (“*’ﬂ""‘)
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4. Enter a display name for the installation.

! Summary |-infe.| Options |

€S54 Web Standard Install | [Adobe instaliers )

File Name
C54 Web Standard.dmg

| This file s a disk image contalning an installer (Mac OS5 X or an Adobe Installer/ Updater)
Info

Crrotous) E-Nexe—)

5. Click the Options tab and set the installation options.

[ Summary _Info | Options |

Installation Options

Priority: Installation Language: en_US

Serial Number: | AAAAAA-BBBEBBE-CCCCCC-DDDDDD-EEEEEE |
™ Suppress Installer Dock Icon ™ ignore Conflicting Processes
| Product Name \Version |
Adobe Contribute C54 5.0 |
Adobe Dreamweaver C54 10.0
Adobe Fireworks CS4 10.0
Adobe Flash C54 10.0
Adobe Version Cue €54 Server 4.0 |
Adobe Creative Suite 4 Web Standard 4.0

( selectan ) ( Select Nome )

Default User Setti

™ Suppress EULA ™ Suppress Registration ™ Suppress Updates

Installation Limitations

Stage: [@aﬂl E | Allow this package to be uninstalled

I ——— Coned) D

6. Click OK.
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6.

7.

Step 3: Create a New Adobe Installation Using the JSS
Log in to the JSS with a web browser.

Click the Settings tab.

Click the Casper Admin link.

Click the New Adobe Install button in the toolbar.

If you have more than one Adobe Installer Image, choose the image on which you want to base your

installation from the Installer Image pop-up menu.

Adobe Installer

Choose the Adobe Installer Image you wish to base
the installation on:

Installer Image: [ €54 Web Standard.dmg 3

Click Save.

Enter a display name for the installation on the Info pane.

Edit Package: Untitled Adobe Installation

0 ¢ -

Info Options Self Healing

) Package Info

Display Name: €54 Web Standard Install | Category: | Adobe Installers

File Name: 'cs4 web Standard.dmg

Note: If you change the file name here, you will need
to do so manually on your Distribution Point(s}

Info:

Notes:
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8.

Click the Options tab and set the installation options. For more information about these options, see the
“Options for an Adobe Install” section.

(] - o

Info Options Self Healing

Installation Options

Priority: | 10 -:] Installation Language: en_US

Serial Number: AAAAAA-BBEEBE-CCCCCC-DDDDDD-EEEEEE

™ Suppress Installer Dock Icon ™ Ignore Conflicting Processes
Payload Version
# Adobe Contribute CS4 5.0
™ Adobe Dreamweaver C54 10.0
™ Adobe Fireworks CS4 10.0
™ Adobe Flash CS54 10.0
[ Adobe Version Cue C54 Server 4.0
[ Adobe Creative Suite 4 Web Standard 4.0

Default User Settings

™ Suppress EULA # Suppress Registration ™ Suppress Updates

Click Save.

Options for Adobe Installations

The Options pane allows you to specify the following information for an Adobe installation:

Priority
Setting the priority determines the order in which packages are installed.

Serial Number
Providing this information identifies the serial number of products you are installing.

Suppress Installer Dock Button
An Adobe Installer icon will appear in the Dock of any logged-in user even if the installer is deployed in
“silent” mode. Selecting this option ensures that the icon does not appear in the Dock.

Ignore Conflicting Processes
An Adobe Installer will fail if conflicting processes are found. Common conflicts include Safari, Firefox, and
Microsoft Office applications. Selecting this option prompts the installer to ignore these conflicts.

As a result, any plug-ins installed for applications that are running during the installation will not be
available until the applications are re-opened.

List of Available Payloads
This provides a list of payloads available in the Adobe Installer Image.

You can use a single Adobe Installer Image to create multiple distributions of Adobe products that may
contain different sets of the payloads.

Suppress EULA
Ensures that users are not prompted with an End User License Agreement (EULA) when opening Adobe
products.
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Suppress Registration
Ensures that users are not prompted to register Adobe products.

Suppress Updates
Ensures that users are not prompted with available Adobe updates when using Adobe applications.

Stage
You can set limitations on the use or deployment of a package by choosing one of the following options
from the Stage pop-up menu:

= Testing—The package can only be deployed using Casper Remote (not a policy) and can only be
pushed to five computers at a time.

= Non-Deployable—The package cannot be deployed. This setting is useful if the package needs to be
taken out of production temporarily for licensing or other reasons.

= Deleted—This setting indicated that the package has been deleted in Casper Admin.

Allow Uninstall
If you want the ability to uninstall the contents of your Adobe installation, select this option to make the
Uninstall feature available when using Casper Remote or a policy.

The Adobe Silent Installer is used to uninstall software. Uninstalling software with this program generally
takes more time than uninstalling normal PKG or DMG packages.

Adding DMGs of Adobe Updaters

Most Adobe updates available for download on the Adobe support website are already in DMG format.

Updaters that support silent installation can be installed without repackaging. If you add the DMG to
Casper Admin and it is not recognized as an Adobe Updater, it is possible that the updater does not
support silent installation.

To add an Adobe Updater DMG:
Open Casper Admin.
Drag the DMG of the Adobe Updater into Casper Admin.

This copies the DMG directly to the master distribution point.

After Casper Admin copies the DMG, the Info pane is displayed. If it does not appear, click the Info button
in the toolbar.

Click the Info tab, and select the This file is a disk image containing an installer (Mac OS X or an Adobe
Installer/Updater) option.

It can take Casper Admin up to 30 seconds to analyze the contents of the DMG When this process is
complete, the Options pane appears and a list of payloads available with the updater is displayed.
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Adding DMGs of Mac OS X Installer DVDs

Installing your operating system using a DMG of the Mac OS X Installer DVD ensures that client computers
receive a clean operating system without requiring you to build a separate OS package.

You create a Mac OS X installation by adding a DMG of the Mac OS X Installer DVD to Casper Admin and
identifying it as a Mac OS X Installer Image.

If you download installer media directly from Apple, it is already in DMG format. If you have installer media
on DVD, you must first create the DMG using Disk Utility.

You can use a single image to create multiple installations, each with custom software and language
settings.

Creating a Mac OS X installation involves the following steps:
Create the DMG.
Add the Mac OS X Installer DVD.

Customize a Mac OS X installation using Casper Admin or the JSS.

Step 1: Create the DMG

Insert the installer DVD into a computer with Mac OS X.

Open Disk Utility from your Utilities folder.

Click the DVD button in the sidebar.

From the menu bar, choose File > New > New Image From <name of the DVD>.

Save as a compressed DMG.

Step 2: Add the Mac OS X Installer DMG
Open Casper Admin.

Drag the DMG of the Mac OS X Installer into Casper Admin.
This copies the DMG directly to the master distribution point.

After Casper Admin copies the DMG, the Info pane is displayed. If it does not appear, click the Info button
in the toolbar.

Click the Info tab and select the This file is a disk image containing an installer (Mac OS X or an Adobe
Installer/Updater) option.

It can take Casper Admin up to 30 seconds to analyze the contents of the DMG.
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When this process is complete, choose a default language for the installation from the Language pop-up
menu.

Note: The initial Mac OS X Installer image cannot be customized beyond the language. For more

information on customizing the installation, see the step entitled “Customize a Mac OS X Installation
Using Casper Admin/the JSS".

[ Summary  Info | Options.|

Installation Options

Mac 05 X Installation Disk

This disk image has been identified as a Mac 05 X Installation Disk.

The Casper Suite can utilize this disk image to perform a clean install
of Mac 0S X.

Installing this package will install Mac OS X with the default options.
To create a customized installation, click the Create Custom OS Install
button.

Language: | English B E Create Custom OS Install )

Installation Limitations

Stage: | Deployable B

Previous ) [ MNext ) Cancel |

Click OK.

Step 3: Customize a Mac OS X Installation Using Casper Admin

Open Casper Admin.

Select the Mac OS X installation on which you want to base your new installation.

Click the Info button in the toolbar.

Click the Options tab and click the Create Custom OS Install button.
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5. Enter adisplay name for the installation on the Info pane.

[ summary [Sinfo-l Options |

Dis) Name
ICUSIMI'I Mac 05 X Snow Leopard Install

File Name
snowleopard_10a432userdvd.dmg

Category
| (Operaung Systems -+

-_\,_ﬁ This file is a disk image containing an installer (Mac 05 X or an Adobe Installer/Updater)
Infa

= = Cod) D

6. Click the Options tab again and select the checkbox next to each package you want to install.

[ Summary  Info |-Options|

Options.

[ AdditionalFonts
» LanguageTranslations
» PrinterDriversGroup
! QuickTimePlayer?
] Rosetta
0 x11

Language: I English i

( Create Custom OS Install )

suge: (Deployable 18

(Previows) (e ) Coned) S

Click OK.

Step 3: Customize a Mac OS X Installation Using the JSS
Log in to the JSS with a web browser.

Click the Settings tab.
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3. Click the Casper Admin link.

4. Click the link for the Mac OS X installation on which you want to base the new installation.
5. Click the Options tab and click the Create Custom OS Install button.

Edit Package: snowleopard_10a432userdvd.dmg

0 w v

Info Options Self Healing

) Package Opti

1 Mac OS X Installation Disk

This disk image has been identified as a Mac 05 X Installation Disk.
The Casper Suite can utilize this disk image to perform a clean install
of Mac 08 X.

Installing this package will install Mac OS X with the default options.
To create a cusomized install, click the Create Custom OS Install
button.

Language: Create Custom 05 Install

_Installation Limitations

Stage:

6. Enter adisplay name for the installation on the Info pane.

Edit Package: snowleopard_10a432userdvd.dmg

0 @ L

Info Options Self Healing

_ Package Info

Display Name:  Clean 05 X Install | Category: | Operating

File Name: |sncnnrleupard_lﬂa-ﬁZuserdvd.dmg |

Note: If you change the file name here, you will need
to do so manually on your Distribution Pointi(s)

Info:

Notes:
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7.

Click the Options tab and select the checkbox next to each package you want to install.

Edit Package: Clean OS X Install

(] - v

Info Options Self Healing

Package Options

=] AdditionalFonts
=] EssentialSystemSoftware
> LanguageTranslations
» PrinterDriversGroup
B8 QuickTimePlayer7?
= Rosetta
O |x11
Language: (Engish —8)

Installation Limitations

Stage: | Deployable B‘

G o)

Click Save.

Indexing Packages

Indexing creates a log of the individual files contained within a package.

Packages must be indexed before you can perform the following tasks:
= Uninstall the package using a policy or Casper Remote.

= Use the Self Healing feature.

= Search the contents of the package using the JSS.

= Create Application Difference reports.

To index a package:
Open Casper Admin.
If prompted, authenticate to the JSS.

Select the package that you want to index in the Package pane, and then click the Index button at the
bottom of the pane.

The username for an account on the client computer is displayed by default. Enter the corresponding
password, and then click OK.

When the indexing process is complete, Casper Admin defaults back to the main window.

From the menu bar, choose File > Save.
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Enabling the Self Healing Feature

Self Healing is a maintenance feature used to ensure that the files from a package remain in their originally
configured state on the client computer. For instance, if the permissions for an application installed on

a client computer are changed due to an overwrite, Self Healing will detect the change and reinstall the
application as originally configured.

Self Healing determines whether a maintenance action is needed by comparing the files in a package to
those on the client computer. If the files on the client computer do not match those in the package, a Self
Healing action is triggered.

There are two components that make up the Self Healing process:

= Triggering files-These are the files that you want to monitor for changes. If, at any time, the client
computer does not contain matching triggering files, Self Healing will perform the specified
maintenance action.

= Self Healing actions—There are three maintenance actions that Self Healing can perform in the event
that the triggering files on the client computer do not match those in the package:

Reinstall the Entire Package
Reinstall the Triggering File

« Send an Email Notification

This section explains how to specify these components of the Self Healing process.

Note: Before you enable Self Healing on a package, the package must be indexed. See the “Indexing
Packages” section for details.

To enable Self Healing:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Casper Admin link.

In the list of packages, click the link for the package on which you want to enable Self Healing.
Click the Self Healing tab and select a reinstallation option.

If you want an email notification to be sent each time a Self Healing event takes place, select the Send
Email Notification option.

Note: The JSS sends emails to JSS users that have Self Healing notification enabled on their account.

Use the Choose Files, Add All Apps, Add All Fonts, and Add All Plug-ins buttons in the Triggering Files
for Self Healing group box to specify the files for which you want to monitor changes.
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Use the Compare pop-up menu to specify the type of change that you want to monitor for each triggering
file. For instance, if you select “File Exists” from the pop-up menu, Self Healing will be triggered if the
triggering file does not exist on the client computer. If you select “Permissions” from the pop-up menu,
Self Healing will be triggered if the permissions for the file on the client computer do not match those in
the package.

Click Save.

Deleting Packages
If you no longer need a package, you can delete it using Casper Admin or the JSS.

When you delete a package, it is moved from the Packages folder to the Deleted Packages folder that is
located in the Casper Data folder. To permanently delete the package, empty the trash after the package
has been deleted.

After a package is deleted, change the stage to “Deleted” so it cannot be used.

This section explains how to:
= Delete a package using Casper Admin or the JSS
= Empty the trash using Casper Admin or the JSS

To delete a package using Casper Admin:

Open Casper Admin, and make sure the Repository list is highlighted in the sidebar.
Select the packages that you want to delete.

Click the Delete button in the toolbar.

Click OK to confirm the deletion.

To delete a package using the JSS:

Log in to the JSS with a web browser.

Click the Settings tab.

Click Casper Admin link.

In the list of packages, click the link for package that you want to delete.
Click the Options tab and choose “Deleted” from the Stage pop-up menu.

Click Save.

To empty the trash using Casper Admin:
Open Casper Admin.

Click the Empty Trash button in the toolbar.
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Click OK to confirm the deletion.

To empty the trash using the JSS:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Casper Admin link.

Click the Deleted Items button in the toolbar and click Empty Trash.
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Managing Scripts

This section explains how to:
= Add new scripts
= Change script attributes

= Delete scripts

Adding New Scripts

Before you deploy a script, you must add it to the JAMF Software Server (JSS) using Casper Admin and
assign it to one or more distribution points.

There are two ways to add a new script to Casper Admin:
= Drag the script into Casper Admin.
= Copy the script directly to a distribution point.

Dragging Scripts into Casper Admin

When you drag a script into Casper Admin, it is copied to the master distribution point and displayed in
blue text in the Unknown category until you assign it to a software category.

To add a script using Casper Admin:
Open Casper Admin and authenticate to the JSS.

Drag the script from the Finder into the Package pane in Casper Admin.

Copying Scripts Directly to the Distribution Point

This method copies the script to the Scripts folder at the root of the file share. You can enter information
about the script into the JSS manually.

If you open Casper Admin after adding the script, the name of the script is displayed in blue text in the
Unknown category in the sidebar.

To add a script manually:

Add the script to the Scripts folder on your distribution point.
Log in to the JSS with a web browser.

Click the Settings tab.

Click the Casper Admin link.
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Click the New Script button and enter information about the script on the Info pane.

Note: The information entered in the File Name field must match the name of the file exactly.

Click Save.

Changing Script Attributes
You can change the attributes that determine how a script is executed.

This section explains:
= How to change script attributes using either Casper Admin or the JSS
= The attributes listed on the Summary, Info, and Options panes

To change script attributes using Casper Admin:
Open Casper Admin.

Select the script that you want to change.

Click the Info button in the toolbar.

Make changes to the information on the Info and Options panes, and then click OK.

To change script attributes using the JSS:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Casper Admin link and click the name of the script.

Make changes on the Info and Options panes, and then click Save.
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Summary Pane

This pane displays an overview of the script. The button Reveal in Finder button displays the scriptin a
Finder window.

Note: The Summary pane exists in the Casper Admin application only. It is not included in the web
version of Casper Admin.

@8 s a O
m Info  Options
Display Name: turnOffAirport.sh
File Mame: twrnOffAirport.sh
Category: Airport Management Reveal in Finder
Kind: Script Format: Shell Script
Size: nja Priority: After
Date Created: 4/21/10 a1 9:22 AM User Templates: n/a
Date Modified: 4/21/10 at 9:22 AM Existing Users: n/a
J5S 1D: 15 Reboot Required: n/a
Executable: No Stage: Deployable

Computers that have a package receipt for this: n/a
Configurations that this is a member of: 0
Computers that use this for autorunning: n/fa

oo ———— Conel) ()
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Info Pane

This pane allows you to modify basic information about a script.

M Information for turnOffAirport.sh

[ Summary |info- Options |

Display Name Category
| wrnOffAirport.sh [ Airport Management &)
File Name

twrnOffAirport.sh

mage containing an installer (Mac OS5 X or an Adobe Installer/Updater)

info
Naotes
o |~ a——— A
Previous | [ MNext Cancel ) @

The following attributes are displayed on this pane:

Display Name
This is the customizable name that identifies a script when it is displayed in a list of scripts or policies. The
display name does not have to match the name of the script file.

File Name

This is the name of the script file. If you change a filename using the web version of Casper Admin, you
must manually update the filename on each distribution point. If you change a filename using the Casper
Admin application, this information is automatically updated for you.

Category
This identifies the organizational category to which a script belongs.

Info
The information displayed to the administrator when a script is being deployed.

Notes

Notes are only displayed in Casper Admin. They are helpful when tracking information about a script, such
as who created it and when it was created.
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Options Pane

This pane allows you to specify deployment information and limit the operating systems on which a script
can be run.

OB Information for turnOffAirport.sh

| Summary Info . Options. |

Script Options
Priority: | After -‘3
The first 3 parameters are predefined in every SCript as mount point, computer name and wsername
Parameter 4 Label; | 1 Parameter 8 Label;
Parameter § Label: Parameter 9 Label:
Parameter 6 Label: Parameter 10 Label: [
Parameter 7 Label: | Parameter 11 Label: |

Script Limitations

Stage: | Deployable [ ‘3
05 Requirements:

Enter possible matches (such as 10.4 or 10.4.1) separated by commas. If
you would like to include all versions of 10.4, enter "10.4.x",

—— | A—— ¥ ———
Previous Next Cancel @

The following attributes are displayed on this pane:

Priority

This determines the order in which scripts will run. For example, you can choose whether a script should
run before the imaging process, after the imaging process, or the first time the computer boots after
imaging.

Parameter Labels
Three parameters are predefined for every script by default, but you can assign up to eight additional
parameters.

You can enter names for these additional parameters in the Parameter Labels fields. If you do not enter a
name, the script will be displayed as “Parameter x”in deployment interfaces.

Stage
You can limit how a script is used and deployed by choosing one of the following options from the Stage
pop-up menu:

= Testing—The script can only be deployed using Casper Remote (not a policy), and can only be pushed
to five client computers at a time.

= Non-Deployable—The script cannot be deployed. This setting is useful if the script needs to be taken
out of production temporarily.

= Deleted—The script has been deleted from Casper Admin.
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OS Requirements
If certain operating system requirements are needed to run a script, enter the requirements in this field
using the same guidelines that you would use for a package (see the “Managing Packages” section).

Deleting Scripts
If you no longer need a script, you can delete it using Casper Admin or the JSS.

When you delete a script, the script file is moved from the Scripts folder to the Deleted Scripts folder that is
located in the Casper Data folder. To permanently delete a script, empty the trash after the script has been
deleted.

After a script is deleted, change the stage to “Deleted” so it can’t be used.

This section explains how to:
= Delete a script using Casper Admin or the JSS
= Empty the trash using Casper Admin or the JSS

To delete a script using Casper Admin:

Open Casper Admin, and make sure the Repository list is highlighted in the sidebar.
Select the scripts that you want to delete.

Click the Delete button in the toolbar.

Click OK to confirm the deletion.

To delete a script using the JSS:

Log in to the JSS with a web browser.

Click the Settings tab.

Click Casper Admin link.

In the list of scripts, click the link for the script that you want to delete.
Click the Options tab and choose Deleted from the Stage pop-up menu.
Click Save.

To empty the trash using Casper Admin:
Open Casper Admin.
Click the Empty Trash button in the toolbar.

Click OK to confirm the deletion.
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To empty the trash using the JSS:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Casper Admin link.

Click the Deleted Items button in the toolbar and click Empty Trash.
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Managing Printers

This section explains how to:
= Add new printers
= Change printer attributes

= Delete printers

Adding New Printers

Before you deploy a printer, you must add it to the JAMF Software Server (JSS) using Casper Admin as a
deployable object.

To add a printer using Casper Admin:

Open Casper Admin and authenticate to the JSS.

Click the Add Printers button in the toolbar.

Authenticate locally if prompted.

Select the checkbox next to each printer you want to add.

Using the Category pop-up menu, choose the category to which the printers should be added, and then
click the Add button.

Add Name Kind
E Printerl Generic PostScript Printer
E Printer2 Generic PostScript Printer

Category: | Printers ‘éi Cancel )

Changing Printer Attributes
Printers, like packages and scripts, have attributes that determine how they are organized and deployed.

This section explains:
= How to change printer attributes using Casper Admin or the JSS

= The attributes listed on the Summary, Info, and Options panes
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To change printer attributes using Casper Admin:
Open Casper Admin.

Select the printer.

Click the Info button in the toolbar.

Make changes to the information on the Info and Options panes, and then click OK.

To change printer attributes using the JSS:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Casper Admin link and click the printer name.

Make changes on the Info and Options panes, and then click Save.

Summary Pane

This pane displays an overview of the printer.

Note: The Summary pane exists in the Casper Admin application only. It is not included in the web
version of Casper Admin.

OO Information for Printerl

[Summanr | Info  Options

Display Name: Printerl
File Name: _10_10_10_10.ppd

Category: Development Printers
Kind: Printer Format: n/a
Size: nfa Priority: Normal
Date Created: n/a User Templates: n/a
Date Modified: nfa Existing Users: n/a
JSSID: 1 Reboot Required: nfa
Executable: n/a Stage: Deployable

Computers that have a package receipt for this: n/a
Configurations that this is a member of: 0

Computers that use this for autorunning: n/a
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Info Pane
This pane allows you to modify basic information about a printer.

OB Information for Printerl

[ Summary | Info | Options |

Display Name Category
Printerl | Development Printers B
PPD

_10_10_10_10.ppd
|| This file is a disk image containing an installer (Mac OS X or an Adobe Installer/Updater)

Info

Notes

Coancel) @RENND

The following attributes are displayed on this pane:

Display Name
This is the customizable name that identifies a printer when it is displayed in Casper Imaging, Casper
Remote, or policies.

This name can differ from the Postscript Printer Description file (PPD).

File Name
This is the name of the Postscript Printer Description file (PPD).

Category
This identifies the organizational category to which a printer belongs.

Info
The information displayed to the administrator when a printer is being deployed.

Notes

Notes are only displayed in Casper Admin. They are helpful when tracking information about a printer or
package, such as who created it and when it was built.
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Options Pane

This pane allows you to specify deployment information and limit the operating systems to which a printer
can be mapped.

NNLO Information for Printerl

[ Summary = Info | Optiens ]

Printer Options

|| Make Default when imaging

Printer Limitations

Stage: | Deployable ) ¢]

05 Requirements:

Enter possible matches (such as 10.4 or 10.4.1) separated by commas.
If you would like to include all versions of 10.4, enter “10.4.x".

| Previous | [ Next [ Cancel ) @
— —

The following attributes are displayed on this pane:

Stage
You can limit how a printer is used and deployed by choosing one of the following options from the Stage
pop-up menu:

= Non-Deployable—The printer cannot be deployed. This setting is useful if the package needs to be
taken out of production temporarily for licensing or other reasons.

= Deleted—The printer has been deleted from Casper Admin.

Deleting Printers
If you no longer need a printer, you can delete it using Casper Admin.
After a printer is deleted, change the stage to “Deleted” so it cannot be used.

This section explains how to:
= Delete a printer using Casper Admin or the JSS

= Empty the trash using Casper Admin or the JSS

To delete a printer using Casper Admin:

Open Casper Admin and make sure the Repository list is highlighted in the sidebar.
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Select the printers that you want to delete.
Click the Delete button in the toolbar.

Click OK to confirm the deletion.

To delete a printer using the JSS:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Casper Admin link.

In the list of printers, click the link for the printer that you want to delete.

Click the Options tab and choose “Deleted” from the Stage pop-up menu.

Click Save.

To empty the trash using Casper Admin:
Open Casper Admin.
Click the Empty Trash button in the toolbar.

Click OK to confirm the deletion.

To empty the trash using the JSS:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Casper Admin link.

Click the Deleted Items button in the toolbar and click Empty Trash.
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Managing Dock Items

Adding Dock Items

Before you deploy a Dock item, you must add it to the JAMF Software Server (JSS) using Casper Admin as a
deployable object.

To add a Dock item:

1. Open Casper Admin.

2. Click the Add Dock Items button in the toolbar.

3. Select the checkbox next to each item you want to add, and then click the Add button.

>
=Y
o

Type
App
App
App
App
App
App
App
App
App
App
App

File

Name

App Store

Stickies

Quicken Essentials
Evernote

Microsoft Word

iTunes

Adaobe Acrobat Pro
Adobe InDesign CS5.5
Adobe Photoshop C55.1
OmniOutliner Professional
Adium

Documents

Path to item
file://localhost/Applications/App%20Store.app/
file://localhost/Applications/Stickies.app/

file:/ flocalhost Applications/ Quickenf20Essentials.app,
file://localhost/Applications/Evernote.app/

file:/ flocalhost/ Applications, Microsoft#200ffice®202011 /...
file://localhost/Applications/iTunes.app/

file:/ flocalhost/Applications/ Adobe?t2 0Aarobari2 0X20Pr..

file:/ flocalhost/ Applications/Adobe?2 OInDesigri20CSS5.5...

file:/ flocalhost/Applications Adobe’2 0Photoshopi2 0CSS....
file:/ flocalhost/ Applications/OmniOutiner#2 OProfessional....|

file:/ /localhost/Applications/Adium.app
file:/{localhost/Users /Erin/Documents/

Mote: Individual Dock items can be deployed with Casper Remote
or with a Policy. They cannot be deployed during imaging with

Casper Imaging and therefore cannot be assigned to a | Cancel |

Configuration.

Deleting Dock Items

If you are no longer using a Dock item, you can delete it using Casper Admin.

To delete a Dock item:

1. Open Casper Admin, and make sure the Repository list is highlighted in the sidebar.

2. Select the items you want to delete.

3. Click the Delete button in the toolbar.

4. Click OK to confirm the deletion.
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Creating Directory Bindings

Directory bindings bind client computers to directory services. You can create the following directory
bindings:

= Active Directory (using Apple’s built-in tools)
= Open Directory (using Apple’s built-in tools)
= Active Directory using Likewise

= Active Directory using ADmitMac

= Active Directory using Centrify

This section explains how to create each directory binding in the JAMF Software Server (JSS).

To create an Active Directory binding:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Casper Admin link.

Click the New Directory Binding button in the toolbar.

Select the Active Directory Binding (built into Mac OS X) option and click the Continue button.

Enter a display name for the binding.
This is an arbitrary name that allows you to choose the correct binding if more than one exists.

Enter the Active Directory domain.

Enter the username and password for an Active Directory account that has permissions to add computers,
and enter the password again to verify it.

In the Computer OU field, enter the OU in which the computer object should be placed.

Edit Directory Binding: New AD Binding

0 13 o B §

General User Experience AD Mappings Administrative

Display Name: New AD Binding

Active Directory Domain:  ad.mycompany.corp

Network Admin Username: Service

Password: ssssssss

Verify Password: | sesssses ]

Computer OU: | CN=computers,DC=domain,DC=company,DC=com

Priority: | 1 B‘
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10.

11.

12.

10.

11.

If you are binding client computers with more than one directory binding, use the Priority pop-up menu
to specify the order in which the bindings should be applied.

Enter any additional information on the User Experience, AD Mappings, and Administrative panes.

The information specified on these panes is the same information entered when using Apple’s Directory
Utility application.

Click Save.

To create an Open Directory binding:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Casper Admin link.

Click the New Directory Binding button in the toolbar.

Select the Open Directory Binding (built into Mac OS X) option and click the Continue button.

Enter a display name for the binding.
This is an arbitrary name that allows you to choose the correct binding if more than one exists.

Enter the DNS name or IP address for the server hosting the Open Directory service.

If you use SSL to bind to the Open Directory service, select the Encrypt Using SSL checkbox.

Edit Directory Binding: New Open Directory Binding

General

Display Name: New Open Directory Binding

DNS Name or IP Address: [ud.mvcumpan\r.com ]

[ Encrypt Using SSL

# Use for Authentication
# Use for Contacts

[CJPerform Secure Bind

Priority: | 1 5‘

(o) (o)

If you want to allow users from Open Directory to log in to other bound clients, select the Use For
Authentication option.

If you want users from Open Directory to be listed as contacts on other client computers, select the Use
For Contacts option.

If you want to bind to Open Directory securely, select the Perform Secure Bind checkbox and enter the
username and password for the directory account.
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12.

13.

10.

11.

If you are binding client computers with more than one directory binding, use the Priority pop-up menu
to specify the order in which the bindings should be applied.

Click Save.

To create a Likewise Active Directory binding:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Casper Admin link.

Click the New Directory Bindings button in the toolbar.

Select the Likewise Binding option and click the Continue button.

Enter a display name for the binding.
This is an arbitrary name that allows you to choose the correct binding if more than one exists.

Enter the domain to which you are binding.
Enter the username and password for an administrator account and enter the password again to verify it.

In the Computer OU field, enter the OU in which the computer object should be placed.

Edit Directory Binding: New Likewise Directory Binding

General

Display Name: New Likewise Directory Binding

Domain: ad.mycompany.corp

Network Admin Username: Service

Password: sssssses

Verify Password: | sssssees ]

Computer OU: CN=computers, DC=domain,DC=company,DC=com

Priority: | 1 B‘

coleD)

If you are binding client computers with more than one directory binding, use the Priority pop-up menu
to specify the order in which the bindings will be applied.

Click Save.

To create an ADmitMac Active Directory binding:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Casper Admin link.
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10.

11.

12.

Click the New Directory Bindings button in the toolbar.
Select the ADmitMAC Binding option and click the Continue button.

Enter a display name for the binding.
This is an arbitrary name that allows you to choose the correct binding if more than one exists.

Enter the DNS name or IP address for the server to which you are binding.
Enter the username and password for an administrator account and enter the password again to verify it.

In the Computer OU field, enter the OU in which the computer object should be placed.

Edit Directory Binding: New ADmitMAC Binding

i ] i il a & [

General Home Folders Login Policy Admin ouUs Mappings

Display Name: New ADmitMAC Binding

DNS Name or IP Address: ad.mycompany.corp

Network Admin Username: Service

Password: sssseres

Verify Password: | sssesses ]

Computer OU: CN=computers, DC=domain,DC=company,DC=com

Priority: | 1 B‘

(o) (o)

If you are binding client computers with more than one directory binding, use the Priority pop-up menu
to specify the order in which the bindings will be applied.

Enter any additional information on the Home Folders, Login Policy, Admin, OUs, and Mappings panes.

The information specified on these panes is the same information entered when using Thursby’s
ADmitMac interface.

Click Save.

To create a Centrify Active Directory binding:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Casper Admin link.

Click the New Directory Bindings button in the toolbar.

Select the Centrify Binding option and click the Continue button.

Enter a display name for the binding.
This is an arbitrary name that allows you to choose the correct binding if more than one exists.

Enter the domain to which you are binding.
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8. Enter the username and password for an administrator account and enter the password again to verify it.

9. Inthe Container DN field, enter the DN in which the client computers should be placed.

Edit Directory Binding: New Centrify Directory Binding

0 ()
General Centrify Options

Display Name: New Centrify Directory Binding

Domain: ad.mycompany.corp

Network Admin Username: Service

Password: sesssses

Verify Password: sessssss )

Container DN: CN=computers, DC=domain,DC=company,DC=com

Priority: [E

10. If you are binding client computers with more than one directory binding, use the Priority pop-up menu
to specify the order in which the bindings will be applied.

11. Enter any additional information on the Centrify Options pane.
The information specified on this pane is the same information entered when using the Centrify interface.

12. Click Save.
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Creating Disk Encryption Configurations

The JSS allows you to create disk encryption configurations that you can deploy to activate FileVault 2 on
OS X v10.8 computers.

Creating a disk encryption configuration requires a JSS user account with the “Manage Disk Encryption”
privilege enabled. If you plan to use an institutional recovery key, you need the “Manage Disk Encryption
Institutional Key" privilege enabled as well.

Disk encryption configurations allow you to set the following information:
= The type of recovery key to use for encrypted drives
= The user that will be the enabled FileVault 2 user

Note: A complete workflow for administering FileVault 2 on OS X v10.8 computers is provided in the
"Administering FileVault 2 on OS X Mountain Lion with the Casper Suite" technical paper. You can
download this technical paper from:

http://www.jamfsoftware.com/libraries/pdf/white papers/Administering-FileVault-2-on-OS-X-Mountain-
Lion-with-the-Casper-Suite.pdf

This section explains how to create, edit, and delete a disk encryption configuration.

To create a disk encryption configuration:
1. Loginto the JSS with a web browser.
2. Click the Management tab.
3. Click the Disk Encryption Configurations link.

4. Click the Create Encryption Configuration button.

Disk Encryption Configurations

"

Create Encryption Configuration

Display Name Recovery Key Type Encryption Type
Example Encryption Configuration Individual And Institutional FileVault 2 Edit Delete
New Encryption Configuration Individual Filevault 2 Edit Delete
My Encryption Conifugration Institutional FileVault 2 Edit Delete

5. Enter a name for the disk encryption configuration in the Display Name field.

Create FileVault 2 Configuration

Display Name: New FileVault

Recovery Key Type: | Individual s

FileVault Enabled Users: (") Management Account

(*) Current or Next User

| Cancel | | Save |
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Choose a type of recovery key type option from the Recovery Key Type pop-up menu:
= Individual—Uses a unique recovery key for each client computer.
= |nstitutional—Uses a single recovery key that is shared by client computers.

= Individual and Institutional—Uses a unique recovery key and a shared recovery key for each client
computer.

Individual recovery keys are created and stored in the JSS when the encryption takes place.
Institutional recovery keys must be created with Keychain Access, and then uploaded to the JSS for
storage.

If you plan to use an institutional recovery key type or an individual and institutional recovery key
type, you must first create the institutional recovery key using Keychain Access. For instructions, see
"Creating and Exporting an Institutional Recovery Key" in the "Administering FileVault 2 on OS X
Mountain Lion with the Casper Suite" technical paper, available at:

http://www.jamfsoftware.com/libraries/pdf/white papers/Administering-FileVault-2-on-OS-X-
Mountain-Lion-with-the-Casper-Suite.pdf

If you choose to use an institutional recovery key type or an individual and institutional recovery key type,
upload the recovery key file to the JSS:

Click the Upload button.

b. Click the Choose File button and select the recovery key file.
The recovery key file must be a .p12, .cer, or .pem file.

c. Click the Upload Selected File button.

If you are uploading a .p12 file, you are prompted to enter your password. Enter the password that you
created when you exported the recovery key from Keychain Access.

d. Click the Save button.

Upload FileVault 2 Institutional Recovery Key
Upload your FileWault 2 institutional recovery key. This file should have a .cer, .pem, or .p12 file extension.
| Choose File | no file selected

| Upload Selected File... |

| Cancel | | Save |

Choose the user that you want to be the enabled FileVault 2 user.

=  Management Account—Makes the management account on the computer the enabled FileVault 2
user.

= Current or Next User—Makes the user that is logged into the computer when the encryption takes
place the enabled FileVault 2 user. If no user is logged in, the next user to log in becomes the enabled
FileVault 2 user.

Click the Save button.

To edit a disk encryption configuration:

Log in to the JSS with a web browser.
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Click the Management tab.
Click the Disk Encryption Configurations link.
Click the Edit link across from the disk encryption configuration you want to edit.

Make changes as needed, and then click the Save button.

To delete a disk encryption configuration:
Log in to the JSS with a web browser.

Click the Management tab.

Click the Disk Encryption Configurations link.

Click the Delete link across from the disk encryption configuration you want to delete.

Choose a deletion option, and then click the Delete button.

Verify Deletion

Display Name: Example Encryption Configuration
Delete: (=) Configuration Only
() Configuration and Associated Institutional Recovery Keys
() Configuration and Associated Individual Recovery Keys

() Configuration and All Associated Recovery Keys
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Configuring the Computer Management
Framework

Use the Global and Computer Management Framework settings to control how the JAMF Software Server
(JSS) and the other applications in the Casper Suite interact with client computers.

Global Management Framework Settings

The Global Management Framework settings allow you to configure and manage the following security
components for the JSS:

= JSSURL
= Public key infrastructure (PKI)
= Apple Push Notification service (APNs) certificate

JSS URL

The JSS URL is the URL that client computers connect to when communicating with the JSS. The full URL of
the JSS must be entered on this pane, including the correct protocol, domain, and port. For example:

https://jss.mycompany.com:8443/

If this field is blank or the URL is incorrect, client computers are unable to connect to the server.

To view the JSS URL:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Global Management Framework Settings link.

Click the JSS URL tab.
The URL of the JSS is entered in the JSS URL field.

Global Management Framework Settings

; = g

JS5 URL Public Key Infrastructure Push Notification Certificate

JS5 URL
This is the URL that computers and mobile devices will connect to when communicating with the JS5.
J55 URL: https://norman.local:8443/ Exarple: https:/ jss.mycompany.corm.: 8443/
JSS URL (HTTP): http:/fnorman.local 9006/ Example: hetp:/ /fss.mycompany. com: 9006/

Mote: The JSS URL HTTP is only used for accessing the built-in SCEP server if you
are installing Enrollment Profiles with iPhone Configuration Utility. If your IS5 has
a pre-trusted root certificate, you can leave this field blank.

| cancel | | save |
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Click Save.

Public Key Infrastructure

To ensure the security of over-the-air tasks, the JSS requires a PKI that supports certificate-based
authentication. This includes:

= A certificate authority (CA) with Simple Certificate Enrollment Protocol (SCEP) capabilities

= Asigning certificate

= A CA certificate

If you do not have access to an external CA with SCEP capabilities, you can use the built-in CA that is
enabled by default in the JSS. The built-in CA has the signing and CA certificates uploaded for you.

If your organization uses an external CA with SCEP capabilities, you can integrate it with the JSS using one
of the following methods:

= Create a signing certificate and upload a CA certificate

This method allows you to use the JSS to generate a certificate signing request (CSR) that you will use
to obtain the signing certificate. After you obtain the signing certificate from the CA, upload it and the
CA certificate to the JSS to complete the integration.

= Upload a signing certificate keystore and a CA certificate

This method allows you to include a certificate chain for the signing certificate. To do this, you must
upload a signing certificate keystore (.jks or .p12 file) that includes a private key and its associated
certificate or certificate chain. Once you've selected the certificate to use as your signing certificate,
you can upload a CA certificate or CA certificate bundle to complete the integration.

To integrate an external CA with the JSS:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Global Management Framework Settings link.

Click the Public Key Infrastructure tab.
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Select Use External Certificate Authority and specify information about the CA and the SCEP server.
Be sure to choose the type of challenge password that will be used as the pre-shared secret for enrollment.
= |f you want computers and devices to use the same challenge password, select the Static option.

= |If you have a non-Microsoft CA and want computers and devices to use unique challenge passwords,
select the Dynamic option.

The Dynamic option requires use of the JSS APl and membership in the JAMF Software Developer
Program. Before selecting this option, contact your Account Manager to learn more about the JAMF
Software Developer Program and the additional steps you need to take to use this option.

= |f you have a Microsoft CA and want computers and devices to use unique challenge passwords, select
the Dynamic-Microsoft CA option.

Note: If you want mobile devices to use unique challenge passwords, you must enroll them over-the-air
(OTA). For more information on OTA enrollment, see "Enrolling Mobile Devices OTA".

& ] ]

JSS URL Public Key Infrastructure Push Notification Certificate

Public Key Infrastructure

The JSS requires a signing certificate to encrypt messages between itself and mobile devices. The JSS also
requires information about a SCEP-enabled Certificate Authority. If you do not have access to this, you can
use the one that is bulilt in to your JSS for this purpose.

() Use Built-in Certificate Authority

(*) Use External Certificate Authority

Base URL for the SCEP Server:

The name of the instance: CA-IDENT:

Subject (Representation of a X.500 name):
Subject Alternative Name Type: | None B

Challenge Type
@ static () Dynamic () Dynamic-Microsoft CA

Challenge: ssssssssnnsssnsnasss

Verify Challenge: | sssesessssecscsnssss
Key Size in bits: [ 1024 3 |
Use as digital signature: i)
Use for key encipherment: i)

Fingerprint hex string:

Signing Certificate: Signing and CA Certificate Assistant...

| Cancel | | Save |

Click the Signing and CA Certificate Assistant link.
Choose a method for providing the signing and CA certificates, and then click Continue.
Follow the onscreen instructions.

When you complete the assistant, click Save.

Apple Push Notification Service Certificate

For the JSS to perform over-the-air management tasks, it must be able to communicate with Apple Push
Notification service (APNs). To enable this communication, you must obtain an APNs certificate (.pem)
from Apple and upload it to the JSS.
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The JSS guides you through the process of generating or renewing an APNs certificate from the Apple
Push Certificates Portal. This process requires:

= Avalid JAMF Nation account
To create a JAMF Nation account, go to:
https://jamfnation.jamfsoftware.com/createAccount.html
= Avalid Apple ID

To generate or renew an APNs certificate:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Global Management Framework Settings link.

Click the Push Notification Certificate tab.

To generate an APNs certificate for the first time, click the Create a certificate using the Push Notification

Certificate Assistant link.
To renew your APNs certificate, click the Renew your Push Notification Certificate link.

Choose how you want to obtain the CSR.

= |f the server hosting the JSS has an outbound connection, select Request Signed CSR Automatically
through JAMF Nation. Enter the username and password for your JAMF Nation account, and then click

Continue.

Push Notification Certificate Assistant

Get Signed CSR
L

Get Signed CSR
Before Apple issues a Push Notification Certificate for you to use, JAMF Software must provide you with a signed
CSR. The CSR is generated by your JSS and sent ta JAMF Software. Once JAMF Software has verified the authenticity
of the request, a signed CSR will be returned in a plist file. JAMF Software never has access to the private key used
to generate the CSR.
(®) Request Signed CSR Automatically through JAMF Nation

JAMF Nation Username: Username

() Download CSR and Request Signing Manually

| Upload .p12 File | | Cancel | | Continue |

The JSS connects to JAMF Nation over port 443 and obtains the signed CSR. (You will download the

CSRin the next step.)
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If the server hosting the JSS does not have an outbound connection, select Download CSR and
Request Signing Manually. Then, follow the onscreen instructions to get the CSR signed.

Push Notification Certificate Assistant

Get Signed CSR Request Cert Upload Cert Complete

Get Signed CSR

Before Apple issues a Push Notification Certificate for you to use, JAMF Software must provide you with a signed
CSR. The CSR is generated by your JSS and sent to JAMF Software. Once JAMF Software has verified the authenticity
of the request, a signed CSR will be returned in a plist file. JAMF Software never has access to the private key used

to generate the CSR.

(") Request Signed CSR Automatically through JAMF Nation

(*) Download CSR and Request Signing Manually
1. Download PushCertificateCSR.certSigningRequest
2. Upload PushCertificateCSR.certSigningRequest to JAMF Nation here
3. Download the JAMFSignedCSR.plist file from JAMF Nation
4. Click the Continue button below

Cancel | Continue

[ Upload .p12 File ]

On the Request Cert pane, follow the onscreen instructions to request an APNs certificate from Apple.

Push Notification Certificate Assistant

Request Cert Upload Cert Complete
@

Get Signed CSR

Request Push Notification Certificate From Apple

The )55 has received a signed copy of your CSR from JAMF Nation. This can now be uploaded to Apple
and you will be able to generate your push notification certificate.

1. Download JAMFSignedCSR.plist (This is the signed CSR that JAMF Nation created for you)
2. Go to https://identity.apple.com/pushcert and sign in with a verified Apple ID

o Click Create a Certificate and agree to the Terms of Use

= Upload the JAMFSignedCSR.plist file from step 1.

= When it is available, download the push notification certificate

3. Click Continue

| cCancel | [ Continue |

Note: It is recommended that you sign in to the Apple Push Certificates Portal with a corporate Apple ID,
since the account will be associated with your corporate APNs certificate.

If you are renewing an APNs certificate originally obtained from Apple’s iOS Developer Enterprise Program
(iDEP), you must sign in using the Apple ID for the iDEP Agent account.

On the Upload Cert pane, click Choose File. Select the APNs certificate (.pem) that you want to upload and
click Choose. Then, click Continue in the JSS.

Push Notification Certificate Assistant

Get Signed CSR Request Cert Upload Cert Complete
@

Upload Push Notification Certificate

Upload your Apple Push Notification Certificate. This file should have a .pem file extension.

| Choose File | | | CN=JAMF 10...ority.pem

[ cancel Continue |

[ Back

9. Click Done to save the certificate.
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Computer Management Framework Settings

The Computer Management Framework settings allow you to set up and manage preferences for the
following aspects of client management:

= Client check-in frequency

= Login and logout hooks

= User-initiated enrollment process
= Self Service application

= Application Usage

= Security

Check-In Frequency

The check-in frequency allows you to control how often client computers check the JSS for available
policies.

To view or modify the check-in frequency:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Computer Management Framework Settings link.

On the Check-In Frequency pane, choose a check-in frequency from the pop-up menu.

o ® % 2 - =

Startup ltem  Login/Logout Hooks  Enrollment Process  Self Service  Application Usage  Security

Check In Frequency

Client Check In Frequency

This option allows you to determine how often the clients check for available policies.

Clients check for policies every: | 15 minutes + |

Click Save.

Startup Item

Use this pane to create or remove a startup item and set preferences for how you want to use it. The
following options are displayed on this pane:

Create startup item
Creates a launchd item that executes once at startup. The launchd item is stored in the following location:

/Library/LaunchDaemons/com. jamfsoftware.startupItem.plist

Log startup action
Logs the startup action and IP address of each client computer at reboot
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Check for policies triggered by startup
Enables computers to check the JSS for policies triggered at startup

Apply Computer Level Enforced Managed Preferences
Applies computer-level Managed Preferences

Ensure SSH is running
Ensures SSH is active at reboot using the startup script

To set up or modify startup item preferences:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Computer Management Framework Settings link.

Click the Startup Item tab.

Select or deselect the Create startup item checkbox to create or remove the startup item.

Select or deselect additional options as needed.

(<} ) % a3 ] 7
Check In Frequency Startup Item Login/Logout Hooks Enrollment Process Self Service Application Usage Security
Startup Item
This option will create a startup item on the clients that can log the startup action, trigger policies, apply managed
preferences, and ensure that SSH 1S active.
# Create startup item
# Log startup action
# Check for policies triggered by startup
[ Apply Computer Level Enforced Managed Preferences
|| Ensure SSH is running
| Cancel | | Save |

Login and Logout Hooks

Use this pane to create or remove login/logout hooks and set preferences for how you want to use them.

The following options are displayed on this pane:

Create login and logout hooks
Creates hooks that execute each time a user logs in or logs out

Log username with login and logout
Logs usernames at login/logout and updates the IP address for the computer in the JSS

Check for Policies with login and logout

Runs policies at login or logout that are used for tasks such as extending login/logout hooks by running

custom scripts

161



Apply User Level Managed Preferences
Applies user-level and user-level enforced Managed Preferences

Hide Restore partition at login
Hides the Restore partition when a two or three-scheme partition is in use

Perform login actions in background

Allows large package deployments triggered at login or logout to take place without stopping the user’s

login process

Display status to user during login and logout
Displays the status of non-background login/logout hook actions to users when they log in or out of a
computer

To set up or modify login and logout hook preferences:
Log in to the JSS with a web browser.
Click the Settings tab.

Click the Computer Management Framework Settings link.

Click the Login/Logout Hooks tab.

Select or deselect the Create login and logout hooks checkbox to create or remove login/logout hooks.

() @ % g . |

Check In Frequency Startup ltem Login/Logout Hocks Enrollment Process Self Service Application Usage Security

Login and Logout Hooks

ers. These can be used to log computer usage, check

Warning: If you have existing login hooks on your client computers, they may be overwritten if you enable this option.

|| Create login and logout hooks

| Cancel | | save |

Select or deselect additional options as needed.

Click Save.

User-Initiated Enrollment Process

User-initiated enrollment allows users to enroll their computers using a QuickAdd package. Use the
Enrollment Process pane to enable or disable user-initiated enrollment. When user-initiated enrollment
is enabled, you can use this pane to configure the following settings for the QuickAdd package and the
Login page for user-initiated enrollment:

Management Username and Password
The credentials for the account that you want to use for management. (These fields are required.)

Create this account if it does not exist
Create the management account that you specified if it does not already exist.
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Hide account from OS X Login Window
Hides the management account from users.

Note: This option is only displayed if the Create account if it does not exist checkbox is selected.

Configure SSH (Remote Login) to only allow access for this user
Makes the management account the only account that has SSH access to computers.

Note: This option is only displayed if the Create account if it does not exist checkbox is selected.

Ensure SSH is running
Enables SSH (remote login) on computers that have it disabled.

Check for policies when done
Ensures that computers check for policies immediately after they are enrolled.

Launch Self Service when done
Ensures that computers launch Self Service immediately after they are enrolled.

Login page title and description
Allows you to customize the text that is displayed to users on the Login page of the user-initiated
enrollment process.

Sign QuickAdd package

Ensures that the QuickAdd package is signed and appears as verified to users. Enabling this option allows
users to install the QuickAdd package on computers that have Apple’s Gatekeeper feature set to only allow
applications downloaded from the Mac App Store and identified developers.

Signing the QuickAdd package requires an installer certificate (.p12) from Apple’s Developer Certificate
Utility. To obtain an installer certificate from Apple’s Developer Certificate Utility, you must be a registered
Apple Developer in the Mac Developer Program. To enroll in the Mac Developer Program, visit the
following website:

https://developer.apple.com/programs/mac/

To set up or modify User-Initiated Enrollment preferences:
Log in to the JSS in a web browser.

Click the Settings tab.

Click the Computer Framework Settings link.

Click the Enrollment Process tab.
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5. Enter or modify the management account information as needed.

<] @

Check In Frequency  Startup ltem  Login/Logout Hooks.

2 - =]

Self Service  Application Usage  Security

Enroliment Process

User-Initiated Enrollment Process

User-initiated enroliment allows end users to enroll their computers by navigating to https://10.1.20.130:8443/ fenroll.
The settings below will determine the behavior of the QuickAdd Package your end users will download and install.

¥ Enable User-Initiated Enrollment
Management Account Information

Username: admin
Password: «

Verify Password: |sssssses

(") Create account if it does not exist
(] Ensure SSH is running
() Check for policies when done

Login page title: "compyrer Enraliment

Login page description: [complete this process for secure access to our

Sign QuickAdd package: (|

| Cancel | | Save |

6. Select or deselect additional options as needed.

7. To sign the QuickAdd package, select the Sign QuickAdd package checkbox and upload an installer
certificate (.p12) obtained from Apple’s Developer Certificate Utility.

8. Customize text for the Login page as needed.
This page is displayed to users during the user-initiated enrollment process.

9. Click Save.

Self Service

The Self Service pane allows you to perform the following management tasks for Self Service:
= Automatically install Self Service on all enrolled computers.
= Configure User Authentication preferences.

= Add plug-ins.

For more information about these tasks and how to perform them, see the following sections:
= “Installing Self Service”
= “Managing User Authentication Preferences”

= “Managing Self Service Plug-ins”

Application Usage

Use this pane to enable application usage for client computers. For information about application usage,
see the “Application Usage” section.
To enable application usage monitoring:

1. Login to the JSS with a web browser.

2. Click the Settings tab.
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Click the Computer Management Framework Settings link.
Click the Application Usage tab.

Select or deselect the Enable application usage monitoring checkbox to enable or disable application
usage monitoring, and then click Save.

‘Check In Frequency Startup Item Login/Logout Hooks Enroliment Process. Self Service

% - &
Security

Application Usage

Application Usage Monitoring

This option allows you to track application usage on your clients. Application usage data will be submitted to the JSS each
time an inventory report Is submitted.

o Enable application usage monitoring

| Cancel | | save |

Security

Use this pane to set up or modify the following security preferences for client management:

Enable Certificate-Based Communication
Ensures that all messages from Mac OS X clients to the JSS are signed with a valid signature. The JSS rejects
the message if the signature is invalid. (This option is selected by default for all fresh installs of the JSS.)

Enable Push Notifications for OS X v10.7 or later clients
Allows clients with OS X v10.7 or later to perform secure transactions between the jamf binary and the JSS.

Note: This option is only displayed if certificate-based communication is enabled and an APNs certificate
is uploaded to the JSS. See the “Apple Push Notification Service Certificate” section for more information.

This JSS has a valid certificate installed
Indicates that there is a valid web server certificate installed on the server.

Maximum Clock Skew
Sets a maximum difference in clock settings for the server and enrolled computers.

To set up or modify security preferences:

Log in to the JSS with a web browser.

Click the Settings tab.

Click the Computer Management Framework Settings link.

Click the Security tab.
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5.

6.

7.

Select or deselect options as needed.

Computer Management Framework Settings

(<] @ 3 i) -

Check In Frequency Startup Item Login/Logout Hooks Enroliment Process Self Service Application Usage Security

Security Settings

These options allow you to configure security settings for communication between managed computers and the JSS.

¥ Enable Certificate-Based Communication
(] Enable Push Notifications for OS X v10.7 or later clients

() This JSS has a valid certificate installed
Warning: If you do not have a valid certificate installed on your JSS and you check
the box labeled This JSS has a valid certificate installed, the client computers
will not be able to connect to the JSS until a valid certificate is installed.

Clock Skew: | Do not verify 2|

Warning: If the Maximum Clock Skew is enabled and the UTC time on the client
computers differs more than the selected number of minutes from the UTC time on
the JSS, the client computers will nat accept information from the JSS.

Set or modify a maximum clock skew by choosing an option from the Maximum Clock Skew pop-up

menu.

Click Save.
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6.

Managing Removable MAC Addresses

Computers are identified by their MAC addresses during the imaging process. This makes utilizing USB
Ethernet dongles during imaging problematic, since the JAMF Software Server (JSS) assumes that each
computer with a specific dongle is connected to the same computer.

To work around this issue, you can enter a list of MAC addresses that the JSS should ignore when
identifying a computer.

This section explains how to add, edit, and delete a removable MAC address.

To add a removable MAC address:

Log in to the JSS with a web browser.
Click the Settings tab.

Click the Inventory Options link.

Click the Removable MAC Addresses link.

Click the Add Address button.

Removable MAC Addresses

=
Add Address

No Removable MAC Addresses entered

Enter the MAC address you want the JSS to ignore in the MAC Address field.

Edit Removable MAC Address

MAC Address:

Click the Save button.

To edit a removable MAC address:

Log in to the JSS with a web browser.
Click the Settings tab.

Click the Inventory Options link.

Click the Removable MAC Addresses link.
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5.

6.

Click the Edit MAC Address link across from the MAC address you want to edit and update the address.

Removable MAC Addresses

Add \Add ress

Removable MAC Address
00.10.11.12.13.14

Edit MAC Address = Delete MAC Address

Click Save.

To delete a removable MAC address:

Log in to the JSS with a web browser.
Click the Settings tab.

Click the Inventory Options link.

Click the Removable MAC Addresses link.

Click the Delete MAC Address link across from the MAC address you want to delete.

Removable MAC Addresses

&
Add Address

Removable MAC Address
00.10.11.12.13.14

Edit MAC Address | Delete MAC Address

Click Delete to confirm.
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Policies

Policies allow you to automate remote management tasks on client computers by pre-configuring the
tasks and caching them in the JAMF Software Server (JSS). This reduces the time you spend configuring
individual tasks and pushing them out to computers by allowing clients to initiate the tasks when they
check in with the JSS.

The following tasks are commonly performed with a policy:

= |nstall and uninstall packages.

= Run scripts.

= Add and remove printers.

= Run Software Update.

= Add and remove Dock items.

= Bind clients to directory services.

= Update computer inventory.

= Perform maintenance functions (Self Healing, fix permissions, update computer names, etc.).

* Manage account passwords.

How Policies Work

Using policies to automate remote management tasks allows you to specify the task(s) you want to
perform, when and how often the task(s) should take place, and the clients that should execute the task(s).

After saving the policy, it is stored in the JSS. Each time clients check in with the JSS, they check to see if
any policies are available.

Clients execute policies based on three main criteria: trigger, scope, and execution frequency.

Trigger
A trigger is the action on a client that executes the policy. Clients can execute policies at the following
triggers:
= None (Self Service only)—Users initiate the policy through the Self Service application
= Any—The next time the client checks in with the JSS
= Startup—When the client starts up
= Login—When a user logs in on a client
= Logout—When a users logs out on a client
= Check-In Frequency—This is one of the following intervals:
« 5 minutes
+ 15 minutes
+ 30 minutes

« Hour
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Check-in frequency is configured as part of your Computer Management Framework settings. For
information on how to change the check-in frequency, see the “Changing the Computer Management
Framework” section.

= Other—A custom trigger

Scope

The scope is the computer or group of computers that runs the policy. Scopes can be based on one or
more of the following components:

= |ndividual computers

= Computer groups

= Departments

= Buildings

= | DAP user groups

= Network segments

Execution Frequency

The execution frequency is how often clients execute the policy. This depends largely on the task you
want to perform. For example, if you're installing a piece of software, you may want to choose “Once
Per Computer”to ensure only one copy of the software is installed on each computer. If you're updating
inventory or performing a routine maintenance task, you may want to choose “One Every Day’,“Once
Every Week”, or “Once Per Month”.

Policies can be set at the following execution frequencies:

= Once per computer

= Once per user (At login or logout)

= Once every day

= Once every week

= Once per month (Ev